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Introduction

CATraxx is a quick, efficient, easy-to-use program for organizing your music collection. 
CATraxx is developed by record collectors for record collectors to ensure that you get all 
the features you need.
With CATraxx you can register and look up information about such things as: 

· artist, album title, format, release date,
· company, label, catalog number, 
· condition, playing time, purchase price and current value, 
· song titles, songwriters, producers, 
· studios, musicians, instruments. 

You can add personal comments for both albums and tracks. Twenty special fields enable 
you to customize your catalog. You can even store a bitmap picture of the album cover.
CATraxx uses a relational database model. This means that you register most information 
only once. For example, an artist's name is included in the catalog the first time you add an
album by the artist. Later, you simply choose this name from a list. This type of information
is stored in "lookup" tables which ultimately save time and valuable disk space on your 
computer.
CATraxx lets you work with an unlimited number of databases. This means that you can 
split your collection into different catalogs and organize it to meet your needs. You can also
merge existing databases. CATraxx includes routines for taking and restoring backup of the 
databases you have created.
CATraxx has impressive and powerful search capabilities. You can search for any 
information you have entered in a catalog. CATraxx lets you cross reference up to five 
fields. This is an extremely flexible way to search and query data. CATraxx has templates 
for many types of reports which you can generate to examine on the screen or print out.
CATraxx lets you play CDs from your CD-ROM player.
CATraxx comes with a sample database to get you started and a comprehensive context-
sensitive on-line help system.
Before you start using CATraxx, we recommend that you read the User's Guide. This help 
file is a supplement, and gives you more detailed information. In the section Procedures 
some of the most important procedures (for example, how to create a database or how to 
search) are explained in details. The section Windows contains information about all 
CATraxx's windows and dialog boxes. This is the same information that is displayed when 
you press F1 or press the Help button. In addition to this, the help file contains information
about Menu Shortcuts, The toolbar, Error Messages and Technical Information.

Four different icons are used to indicate important information:

Useful tips.

This is important.



This is very important.

Indicates that you may click the 'other' (usually the right) mouse-button on an object 
(button or list) to activate a popup-menu relevant to this object.



Windows

Main Windows 
Dialog Boxes 



Toolbar

    Add new album
    Add new album that is a copy of the active album
    Update sort order
    Go to album by Album ID
    Go to album by Album title
    Go to album by Artist
    Go to previous album/track on the basis on last search
    Search for albums/tracks
    Show result of last search
    Go to next album/track on the basis on last search
    Mark/unmark active album
    View subset (that is, albums that are marked)
    Calculate total value
    Print active album (full report)
    Go to first album
    Go to previous album
    Go to next album
    Go to last album
    Browse all/marked tracks
    Activate the CD player
    Show help contents

Press one of these buttons to locate the first album where the first field used in the sort 
criteria starts with this letter. For example, if the albums are sorted on Album title and you 
press T, CATraxx finds the first album where the title begins with T.

Click with the 'other' mouse-button on  to activate this popup-menu:
· Sort Automatically

This menu lets you specify (without activating the dialog "Preferences") if you want CATraxx
to automatically update the sort order each time you add a new album.

Click with the 'other' mouse-button  to activate a popup-menu with these options: 
· Find
· Show Field Values
· Simple Search
· Advanced Search
· X-Ref



This menu lets you specify (without activating the dialog "Preferences") what search 
command to activate when you press this button.



Menu Shortcuts

Press To

F2 Go to previous album/track on the basis of last search
F3 Go to next album/track on the basis of last search
F4 Show result of last search (all albums/tracks found in last search)
F5 Go to first album
F6 Go to previous album
F7 Go to next album
F8 Go to last album
F9 Browse all/marked tracks
F11 Update sort order
F12 Disable the conversion to upper case (first letter in each word) as long as this 

button is pressed.
Ctrl+A Link new artist(s) to active album
Ctrl+B Activate window "Browse"
Ctrl+C Copy the selection and put it on the clipboard
Ctrl+D Insert current date
Ctrl+E Activate window "Memo"
Ctrl+H Activate window "Active Album 1"
Ctrl+I Link activate album to CD in CD-ROM player
Ctrl+J Activate window "Active Album 2"
Ctrl+K Activate window "Tracks"
Ctrl+L Go to album by Album title
Ctrl+M Mark or unmark activate album
Ctrl+N Add new album
Ctrl+O Add new album that is a copy of the activate album
Ctrl+P Add up playing time
Ctrl+Q Go to album by Artist
Ctrl+R Activate window "Cover"
Ctrl+T Insert current time
Ctrl+S Save changes
Ctrl+U Go to album by Album ID
Ctrl+V Insert clipboard contents
Ctrl+W Add new item to lookup table
Ctrl+X Cut the selection and put it on the clipboard
Shift+F2 View artists from tracks on active album
Shift+F3 View mixers from tracks on active album
Shift+F4 View musicians from tracks on active album
Shift+F5 View producers from tracks on active album
Shift+F6 View song writers from tracks on active album



Shift+F7 View studios from tracks on active album



Error Messages

482 Default printer not set. Make sure a default printer is set in the Control Panel!
3041 The file VBDB300.DLL has the wrong version and needs to be 

reinstalled. CATraxx's installation program did copy the correct version to your 
hard drive, but this version is now overwritten by another application. You may 
install this file again by following this procedure:
1) Start a "DOS-window" (click on the MS-DOS icon).
2) Insert diskette no. 2 into your diskette drive and type: 

EXPAND A:\VBDB300.DL_ C:\WINDOWS\SYSTEM\VBDB300.DLL
3049 Cannot open database! If you do not exit the program by selecting File/Exit 

(or Close from the main window's Control-menu), for example if a system error 
occurs or there is a power-failure, you may get this error message the next time 
you try to open the database. If this happens, run a utility called FIX that was 
installed to the same directory as CATraxx.

3050 SHARE is not activated! Add SHARE.EXE /L:500 to autoexec.bat (use Notepad) 
and reboot your computer



Technical Support

Technical support is available at no charge if you are a registered user. However, support is 
available only by E-mail or regular mail. Sorry, but we cannot provide telephone support at 
this time. Contact us at:

FNProgramvare
Storgt. 22
N-1531    Moss
Norway

E-mail: fredrik.nordbakke@ostfoldnett.no
World Wide Web: http://www.prodat.no/fnp/catraxx.html

When reporting problems, the more information you can provide the better our response 
can be. If possible, include the following:

What version of Microsoft Windows are you running? For example, Windows 3.1, 
Windows for Workgroups, Windows NT or Windows 95.

· What version of CATraxx are you running? You can determine this by choosing About 
CATraxx from the CATraxx Help menu. Include the entire "version line" in your report; 
for example 2.50.00.

· Is the problem reproducible? If so, how?
· If you see a dialog box with an error message when the problem occurs,    if possible 

include the full text of the dialog box, the text in the title bar and the error number. 
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catraxx.ini

This file is automatically created in the WINDOWS directory (usually C:\WINDOWS) the 
first time you run CATraxx, and contains all user specified preferences, window positions 
and the last database opened.

Do not edit this file manually!



"dbname".ini

Each database you create has a corresponding ini-file with the same name as the database
(for example MUSIC.MDB and MUSIC.INI). This ini-file contains information about the 
browse layout and sort order.



Minimum System Requirements

To run CATraxx you need:
· 386-based PC or better
· Microsoft Windows 3.1 or Windows 95
· 4 Mbytes memory (6 Mbytes is recommended)
· 4 Mbytes available space on the hard disk



Files Needed to Run CATraxx

CATraxx needs the following files:
In the program directory (the same directory where CATRAXX.EXE is located):

CATRAXX.HLP CATRAXX.MEM FIX.EXE

In the SYSTEM directory (usually C:\WINDOWS\SYSTEM):

LHA.DLL CMDIALOG.VBX MHTIP.VBX
MHRUN400.DLL MCI.VBX MSMASKED.VBX
MSAES110.DLL MHCB200.VBX MUSCLE.VBX
MSAFINX.DLL MHCM200.VBX SSDATA2.VBX
MSAJT112.DLL MHPFST.VBX THREED.VBX
MSAJT200.DLL MHPFST.VBX VSVIEW.VBX
VBDB300.DLL MHSL200.VBX
VBRUN300.DLL MHTAB.VBX

Several report files were copied to the program directory during installation: MEMO.LIA 
(line report album), MEMO.LIT, MUSICIAN.LIT (line reports track), DEFAULT.LSA (list 
report album), DEFAULT.LST (list report track), ARTIST1.SRA, ARTIST2.SRA, 
CATEGORY.SRA, COMPANY.SRA, CONDITI.SRA, COUNTRY.SRA, FORMAT.SRA, 
LABEL.SRA (summary reports album), ARTIST.SRT, MIXER.SRT, MUSICIAN.SRT, 
PRODUCER.SRT and SONGWRIT.SRT (summary reports track).
A sample database (SAMPLE.MDB) was also copied to the program directory during 
installation. This database contains information about 30 albums. We recommend that you 
open the sample database the first time you run CATraxx. Most examples in the 
documentation are referring to this database.
In addition, CATraxx will automatically create the file catraxx.ini in your WINDOWS 
directory (usually C:\WINDOWS).



Dialog boxes

A dialog box is window that is shown temporarily after you have selected a command, for 
example chosen a menu option or pressed a button. Dialogs need to be closed before you 
can select another menu option. Buttons with three dots (for example Transfer...) 
activates another dialog box when it is pressed.

Database 
Lookup Tables 
Edit Albums 
Edit Tracks 
Search
Reports 
Miscellaneous



Database

Backup Database 
Browse Layout - Album 
Browse Layout - Track 
Change Sort Order - Album 
Change Sort Order - Track 
Create New Database 
Define Browse Layout 
Define Sort Order 
Export 
Import
Merge Databases 
Open Database 
Restore Backup
Restore Backup To 
Save Database As
Split Database 
Transfer Field Names 
User-defined Fields 



Lookup Tables

Edit Artist 
Edit Category 
Edit Company 
Edit Condition 
Edit Country 
Edit Distributor 
Edit Format 
Edit Instrument 
Edit Label 
Edit Person 
Edit Studio 
Edit User-defined 
Format groups 
Line-up 
Line-up, Add Person 
Line-up, Period 
Line-up, Instrument 
Lookup Table Artist 
Lookup Table Category 
Lookup Table Company 
Lookup Table Condition 
Lookup Table Country 
Lookup Table Distributor 
Lookup Table Format 
Lookup Table Instrument 
Lookup Table Label 
Lookup Table Person 
Lookup Table Studio 
Lookup Table User-defined 
Transfer Lookup Tables 
Transfer Lookup Tables From 



Edit Albums

Adjust Value 
Artist Album 
Load Cover 
Total Value 
View Artist - Edit 
View Artist - Tracks 
View Information From Tracks - Artist 
View Information From Tracks - Mixer 
View Information From Tracks - Musician 
View Information From Tracks - Producer 
View Information From Tracks - Songwriter 
View Information From Tracks - Studio 
View Mixer- Edit
View Mixer - Track 
View Musician - Edit
View Musician - Track 
View Producer - Edit
View Producer - Tracks 
View Songwriter - Edit
View Songwriter - Tracks 
View Studio - Edit
View Studio - Tracks 



Edit Tracks

Active Track 
Add Musician 
Artist Track 
Change Order 
Change Side 
Change Side - New Track 
Default Information 
Instrument 
Mixer 
Musicians 
Producer 
Songwriter 
Studio 
View Tracks 



Search

Advanced Search 
Advanced Search - Sub-criterion 
Cross-references 
Find Track 
Find Album 
Search Result 
Show Field Values 
Show Field Values - Select Value 
Simple Search 
Special Search - Artist Album 
Special Search - Artist Track 
Special Search - Mixer 
Special Search - Musician
Special Search - Producer 
Special Search - Song: More Than One Version 
Special Search - Songwriter 
Special Search - Studios 



Reports

Advanced Filter 
Advanced Filter - Sub-criterion 
Choose Field 
Cover Report 
Discography 
Full Report Album 
Full Report Track 
Heading 
Insurance Report 
Line Report Album 
Line Report Track 
List Report Album 
List Report Track 
Page Setup 
Print Preview 
Properties 
Report - Cross-references 
Report - Show Field Values 
Report Lookup Table 
Simple Filter    
Statistics Report 
Summary Report Album 
Summary Report Track 
View file 



Miscellaneous

About CATraxx 
CD Player 
Change Track Order 
Information 
Preferences 
System Information 



Dialog Backup Database

In this dialog you specify where you want to backup the open database to. Please note that
if a database is too large to fit onto one diskette, it is automatically split in two or more 
parts. The file on diskette no. 1 is named "dbname".001, the file on diskette no. 2 is 
named "dbname".002 and so on.
Please note that you cannot simply copy the necessary file(s) from the diskette(s) to your 
hard disk. You must use CATraxx's internal routines to do this.

Dialog options

Directories
Select the directory where you want to backup the database to.

Drives
Select the drive where you want to backup the database to.

OK
Press this button to accept the selected drive/directory and start the backup process.

Cancel
Press this button to cancel.



Dialog Browse Layout - Album

Use this dialog to select the browse layout you want to activate. Default browse layout is 
Artist, Album title, Format and Released. You may define up to 5 browse layouts 
yourself.

See also: Change Browse Layout Album 

Dialog options

Active layout
Select the layout to activate.

OK
Press this button to activate the selected layout.

Cancel
Press this button to cancel and close the dialog.

Edit
Press this button the edit the selected layout.



Dialog Browse Layout - Track

Use this dialog to select the browse layout your want to activate. Default browse layout is 
Song title, Artist and Album title. You may define up to 5 browse layouts yourself

See also: Change Browse Layout Track 

Dialog options

Active layout
Select the layout to activate.

OK
Press this button to activate the selected layout.

Cancel
Press this button to cancel and close the dialog.

Edit
Press this button the edit the selected layout.

This layout is used when you choose Tracks from the View menu (dialog View Track) and 
not in the window Tracks.



Dialog Change Sort Order - Album

Use this dialog to select the sort order you want to activate. Default sort order is based on 
Artist, Released and Album title.

See also: Change Sort Order Album 

Dialog options

Active sort order
Select the sort order to activate.

OK
Press this button to activate the selected sort order.

Cancel
Press this button to cancel and close the dialog.

Edit
Press this button the edit the selected sort order



Dialog Change Sort Order - Track

Use this dialog to select the sort order you want to activate. Default sort order is based on 
Song title.

See also: Change Sort Order Track 

Dialog options

Active sort order
Select the sort order to activate.

OK
Press this button to activate the selected sort order.

Cancel
Press this button to cancel and close the dialog.

Edit
Press this button the edit the selected sort order.

This sort order is used when you choose Tracks from the View menu (dialog View Track) 
and not in the window Tracks!



Dialog Create New Database

In this dialog you specify the name of the new database you want to create.

Dialog options

Filename
Type the name of the database. The name should be one that easily reminds you of the 
information in the database, for example MUSIC or MUSICLIB. As with other Windows file
names, it cannot have more than eight characters The file extension identifying the 
database, .MDB, is added automatically.

Directories
Select the drive and directory where you want to create the database if it is different 
from the CATraxx directory. In general, we recommend that you do not change the 
directory.

List files of type
Select file type. CATraxx's databases should always have the file extension MDB.

Drives
Select the drive where you want to create the new database.



Dialog Define Browse Layout

In this dialog you specify the fields you want to include in the browse list (window Browse 
or dialog View Tracks).

Dialog options

List 1
This list displays all fields that are available.

>
Press this button to move the selected field from list 1 to list 2.

<
Press this button to remove the selected field from list 2.

List 2
This list displays the fields you have chosen.

Up
Press this button to move the selected field up one line. You may also do this by pressing
Ctrl+Up arrow, or click on the field and then press Ctrl and hold the mouse-button 
down while you drag.

Down
Press this button to move the selected field down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the field and then press Ctrl and hold the 
mouse-button down while you drag.

Title
You may give the layout a name to make it easier to separate the various layouts in the 
dialog Browse Layout - Album or Browse Layout - Track. Maximum length of the title is 
40 characters.

Fixed columns
Enter number of fixed columns. Fixed columns are always shown, even when you use 
the scrollbar to view the columns to the right, that may not initially be shown.

OK
Press this button to save changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Width
Here you may enter the width of the selected column. The width is specified as number 
of characters. If you have selected a non proportional font (like Arial) the width is 
calculated on the basis of the average character width.

Font
Press this button to change the font size and/or style, or to choose another font.



Dialog Define Sort Order

In this dialog you choose the fields that you want to use the sort criterion.

Dialog options

List 1
This list displays all fields that are available.

>
Press this button to move the selected field from list 1 to list 2.

<
Press this button to remove the selected field from list 2.

List 2
This list displays the fields you have chosen.

Up
Press this button to move the selected field up one line. You may also do this by pressing
Ctrl+Up arrow, or click on the field and then press Ctrl and hold the mouse-button 
down while you drag.

Down
Press this button to move the selected field down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the field and then press Ctrl and hold the 
mouse-button down while you drag.

Order
Ascending Letters are sorted from A to Z and numbers from 0 to 9.
Descending Letters are sorted from Z to A and numbers from 9 to 0.

Title
You may give the layout a name to make it easier to separate the various layouts in the 
dialog Change Sort Order - Album or Change Sort Order - Track. Maximum length of the 
title is 40 characters.

OK
Press this button to save changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

In the summary report, records are first sorted on the fields used in the groups and then on
the fields you specify here.

It is not possible to sort on the following fields: Instrument, Mixer, Musician, Producer, 
Songwriter and Studio.



Dialog Export

Use this dialog to export data to an ASCII-file (a plain text file). The item called <dummy> 
is used to specify that CATraxx should include an empty string in this position (for example 
Artist, <dummy> and Album title may give this result; "R.E.M.", "", "Monster").

Dialog options

Browse
Press this button to specify the file to export to.

Separator
Specify whether CATraxx should use a comma or TAB as the separator.

Subset
Check this if you want CATraxx to only export marked albums or tracks.

OK
Press this button to start.

Cancel
Press this button to close the dialog.



Dialog Import

Use this dialog when you want to import data from an ASCII-file (a plain text file). The item 
called <dummy> is used to specify that a field from the ASCII-file should not be imported.
All records must be separated by a character-return (if you open the file in a text editor like
Notepad, all records are then shown on a separate line). All text fields must be contained 
within double-quotation marks ("Automatic For The People"). Logical fields may either be 
specified as T, Y, -1, 1 (true) or F, N, 0 (false). Date fields must use the format 
YYYYMMDD (19960826).

Dialog options

Browse
Press this button to specify the file to import from.

Separator
Specify whether a comma or TAB is used as separator.

OK
Press this button to start.

Cancel
Press this button to close the dialog.

It is only possible to import data about albums, not tracks.



Dialog Merge Databases

In this dialog you specify the database you want to transfer albums from. All albums in this 
database is transferred to the currently open database.

Dialog options

Filename
Enter or select the database you want to transfer the albums from.

Directories
Select the directory where the database is located.

List files of type
Select file type. CATraxx's databases should always have the file extension MDB.

Drives
Select the drive where the database is located.



Dialog Open Database

In this dialog you specify the database you want to open.

Dialog options

Filename
Enter the database you want to open.

Directories
Select the directory where the database is located if it is different from the CATraxx 
directory.

List files of type
Select file type. CATraxx's databases should always have the file extension MDB.

Drives
Select the drive where the database is located if it is different from the CATraxx 
directory.



Dialog Restore Backup

In this dialog you specify where the database you want to restore is located.

Dialog options

Directories
Select the directory where the backup is located.

Drives
Select the drive where the backup is located.

OK
Press this button to accept the selected drive/directory and continue.

Cancel
Press this button to cancel.



Dialog Restore Backup To

In this dialog you specify where you want to restore the database to.

Dialog options

Directories
Select the directory where you want to restore the database to.

Drives
Select the drive where you want to restore the database to.

OK
Press this button to accept the selected drive/directory and start the restore process.

Cancel
Press this button to cancel.



Dialog Save Database As

In this dialog you specify the new name you want to save the database as.

Dialog options

Filename
Type the name of the database. The file extension identifying the database, .MDB, is 
added automatically.

Directories
Select the directory where you want to save the database.

List files of type
Select file type. CATraxx's databases should always have the file extension MDB.

Drives
Select the drive where you want to save the database.



Dialog Split Database

In this dialog you specify the name of the database you want to transfer the marked 
albums to.

Dialog options

Filename
Type the name of the database. The file extension identifying the database, .MDB, is 
added automatically.

Directories
Select the directory where the database is located/is to be created.

List files of type
Selelct file type. CATraxx's databases should always have the file extension MDB.

Drives
Select the drive where the database is located/is to be created.

If you have chosen to transfer albums to a new database, an existing database with the 
same name will be deleted.



Dialog Transfer Field Names

In this dialog you specify the database you want to transfer the field names from.

Dialog options

Filename
Type the name of the database you want to transfer the field names from.

Directories
Select the directory where the database is located.

List files of type
Select file type. CATraxx's databases should always have the file extension MDB.

Drives
Select the drive where the database is located.



Dialog User-defined Fields

Use this dialog to change the name of the special info fields. You may use these fields to 
store whatever information you need.

Dialog options

OK
Press this button to save changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Transfer
Press this button to transfer field names from another database.

None of the user-defined fields are shown in field lists (for example when you want to 
search or print a report) before you have told CATraxx that it is in use. You do this by 
choosing Preferences from the File menu and selecting the fields you are using in the list 
box Show fields.



Dialog About CATraxx

This dialog displays program information, version number and copyright.



Dialog CD Player

In this dialog you control the CD in your CD-ROM. If the CD is linked to the database, 
CATraxx reads Artist and Album title from the album, and Artist, Song title and 
Songwriter from the current track.

Dialog options

Start
Press this button to play the CD from the start of the first track. If in 'Random Order' 
mode, play is started at a randomly selected track.

Pause
Press this button to pause the CD at the current position or continue play from a 
previously paused position.

Previous track
Press this button to start play at the previous track.

Next track
Press this button to start play at the next track. If in 'Random Order' mode, play is 
started at a randomly selected track from the tracks that have not yet been played.

Stop
Press this button to stop the CD.

Eject
Press this button to eject the CD from the CD-ROM (please note that some CD-ROMs do 
not support this).

Close
Press this button the close the dialog.

Scrollbar
Use the scrollbar to change the position within the current track.

Track order
Press this button to change the track order.

Information
Press this button to view the length of all tracks and the total length of the CD.

Random
Check this to play the tracks in random order (sometimes called 'shuffle mode'). 

Repeat
Press this button to re-start track 1 when the last track has finished.

Introscan
Press this button to play only the first 20 seconds of each track on the CD.

You link a CD to the active album by choosing Link to CD from the Album menu.

If you are using Windows 95, please see CD-ROM And Windows 95.



Dialog Change Track Order

In this dialog you change the order of the tracks. Changes to the track order are 
automatically saved and used next time the same CD is played.

Dialog options

List 1
This list displays all tracks that are available.

>
Press this button to move the selected track from list 1 to list 2.

<
Press this button to remove the selected track from list 2.

>>
Press this button to remove all tracks from list 2.

List 2
This list displays the tracks you have chosen.

Up
Press this button to move the selected track up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the field and then press Ctrl and hold the mouse-
button down while you drag.

Down
Press this button to move the selected track down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the field and then press Ctrl and hold the 
mouse-button down while you drag.

OK
Press this button to save changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

If this list is empty, all tracks are accessed in the same order as they appear on the CD.



Dialog Information

This dialog displays the length of all tracks and the total length of the CD.



Dialog Preferences

In this dialog you change user preferences.

Dialog options

Data fields/Show fields
Select the fields you want to include in lists (drop-down lists and list boxes) in search 
and report dialogs. By default, none of the special info fields (user-defined fields) are 
selected.

Data fields/Song title
Check this if you want CATraxx to include (live) in the song title when the song is a live 
recording, for example Losing My Religion (live).

Data fields/Sorting name
Check this if you want names (mixer, musician, producer and songwriter) to be 
displayed using this format: Last name, First name (Stipe, Michael) when the field is
used in the active sort order. This applies to the browse lists (window Browse and dialog 
View Tracks) and reports. In all other cases, names are always displayed using the 
format First name Last name (Michael Stipe), excluding lookup lists where the last 
name always is displayed first. This option also affects artists (for example The Alarm 
vs. Alarm, The and Neil Young vs. Young, Neil).

Data entry/Sort automatically
Check this if you want CATraxx to automatically update the sort order each time a new 
album is saved.

Data entry/Update position in lists automatically
Check this if you want CATraxx to automatically update lookup lists when you activate a 
speed search. This applies to the drop-down lists (for example Company or Format) in 
the windows Active Album1 and Active Album 2, and in all other list boxes that display 
information from the lookup tables (for example when you choose Artist from the 
Lookup menu). Please note that the update process may take some time if you have 
added a lot of items and your machine is not that fast. Normally this is not a problem, 
and we recommend that you check this option.

Data entry/Upper case first character
Check this if you want CATraxx to make the first character in each word upper case as 
you type it. This applies to all data fields, except for the memo fields.

Data entry/Max items drop-down list
Enter the maximum number of items to display simultaneously in a drop-down list that 
shows information from a lookup table. 10 items is displayed by default.

Data entry/New album - test for
Check Album ID if you want CATraxx to check if the album ID already is used when you 
add a new album. Check Artist/Album title/Format if you want CATraxx to check if 
you have already added this album (based on Artist, Album title and Format).

Data entry/Songwriter
Check this if you want to separate who wrote the lyrics and who wrote the music when 
you specify songwriters.

Data entry/New musician - Add instrument automatically
Check this if you want CATraxx to automatically show the dialog Instrument  where you 
specify instrument(s), when you have added a new musician.

Misc/Window Tracks - show artist
Specifies whether the artists that perform on the tracks are shown in the window Tracks 



or not.
Never The artists are never shown.
When different
from album The artists are only shown when different from the artists on the 

album.
Always The artists are always shown.

Misc/Use bold font
Check this if you want CATraxx to use a bold font (common in Window 3.1) instead of a 
normal font (common in Windows 95) in all windows. You need to re-start CATraxx to let 
this option have effect on the windows Active Album1, Active Album 2, Memo, Cover and
Tracks. Please note that the window Browse uses it's own font that you may change by 
choosing Browse layout/Album from the File menu.

Misc/Use compression - Backup
Check this if you want CATraxx to compress the database when taking backup. When 
using compression the database may occupy as little as ¼ of the original size.

Misc/Use compression - Save pictures
Check this if you want CATraxx to compress the pictures (album cover). When using 
compression bitmaps may occupy as little as 1/8 of the original size. Please note that 
this only affects new pictures you add. Choose Compress pictures to compress 
pictures that already are in the database.

Misc/Compress pictures
Press this button to compress all pictures in the database.

Misc/Decompress pictures
Press this button to decompress all pictures in the database. Uncheck Use 
compression - Save pictures if you do not want to compress new pictures you add.

Reports/Mono printer
Check this if you want to always print in black and white, no matter what color you have
chosen. This way, you can use colors in the print preview, but not on the print-out.

Reports/Font
Specify the fonts you want to use. These fonts are used by default, but you may override
this in the various reports (by pressing the Page setup button).
Heading Is used on the heading that is printed at the beginning of the first page.
Normal Is used on the rest of the report.

Reports/Margins
Specify the margins that are used by default in all reports. You may override this in the 
various reports (by pressing the Page setup button).
Left Left margin, in inches or centimeters.
Right Right margin, in inches or centimeters.
Top Top margin, in inches or centimeters.
Bottom Bottom margin, in inches or centimeters.

Reports/Units of measurement
Select either centimeters or inches.

Reports/Filter
Select whether you want to use a simple or advanced filter in the reports.

Search/Toolbar
Select the search command you want to activate when you press the search-icon on the 
toolbar.

Search/Show number of records found
Check this if you want CATraxx to show you how many records (that is, albums or tracks)
that were found in the last search.



Search/Search tracks -    show albums
Check this if you want CATraxx to mark the tracks that were found when you search for 
tracks, but want the albums these tracks are located on as the search result. You may 
then choose Tracks from the View to look at these tracks.

OK
Press this button to save and activate the changes, then close the dialog.

Cancel
Press this button to close the dialog without saving any changes.



Dialog System Information

This dialog gives you the following information:
· Name of the open database
· Number of albums (total/marked/deleted)
· Number of tracks (total/marked)
· CATraxx version
· DOS version
· Windows version
· Memory
· Free system resources (GDI/USER)



Dialog Edit Artist

In this dialog you enter information about the artist.

Dialog options

Artist
Maximum length is 50 characters. We recommend that you use the format Last name, 
First name for solo artists (for example "Young, Niel" or "Hersh, Kristin"). The name 
is then first sorted on last name, then on first name. Group names with "The" in the 
name, should be entered like this; "Alarm, The" or "Lemonheads, The". Always use 
comma as the separator between the first and last name.

Group/Solo artist
Specify whether the artist is a group or a solo artist.

Formed/Born
Enter the date or year when the group was formed, or the date or year the person was 
born.

Disbanded/Dead
Enter the date or year when the group was disbanded, or the date or year the person 
died.

Country
Specify the country where the artist is from.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Line-up
You may specify line-up (that is, the members of the group). This information can be 
used when you want to specify musicians that participate on a specific track. If you use 
this feature, you save a lot of time when you add new tracks.

Press Ctrl+W when the drop-down list Country has the focus to add a new item to the list.

Press Ctrl+Enter to add a new line to the memo field.

Click with the 'other' mouse-button on the drop-down list to activate a popup-menu with 
these options:
· New Country
· Edit Lookup Table



Dialog Edit Category

In this dialog you enter information about the category.

Dialog options

Category
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Company

In this dialog you enter information about the company.

Dialog options

Company
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Condition

In this dialog you enter information about the condition.

Dialog options

Condition
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Country

In this dialog you enter information about the country.

Dialog options

Country
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Distributor

In this dialog you enter information about the distributor.

Dialog options

Distributor
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Format

In this dialog you enter information about the format.

Dialog options

Format
Maximum length is 50 characters.

Items
Select number of items; 1 for an ordinary album, 2 for a double album and so on.

Sides
Select number of sides; 1 for albums with only one side like a CD and 2 for albums with 
two sides like a LP.

Group
Specify what group the format is to be linked to. CATraxx uses these format groups when
creating the statistics report. Please note that an ordinary album and a double album 
must be separated, for example LP and Double LP. However, they can both be linked to 
the same format group.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Groups
Press this button to edit the format groups.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Instrument

In this dialog you enter information about the instrument.

Dialog options

Instrument
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Label

In this dialog you enter information about the label.

Dialog options

Label
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit Person

In this dialog you enter information about the person. Please note that this lookup table is 
used by the following fields; Mixer, Musician, Producer and Songwriter.

Dialog options

Name
Maximum length is 50 characters. We recommend that you use the format Last name, 
First name (for example "Young, Niel" or "Hersh, Kristin"). The name is then first 
sorted on last name, then on first name.

Name ID
CATraxx lets you only add unique names. If two different persons have the same name, 
use this field to separate them. Maximum length is 5 characters.

Born
Enter the date or year when the person was born.

Dead
Enter the date or year when the person died.

Country
Specify the country where the person is from.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+W when the drop-down list Country has the focus to add a new item to the list.

Press Ctrl+Enter to add a new line to the memo field.

Click with the 'other' mouse-button on the drop-down list to activate a popup-menu with 
these options:
· New Country
· Edit Lookup Table



Dialog Edit Studio

In this dialog you enter information about the studio.

Dialog options

Studio
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.



Dialog Edit User-defined

In this dialog you enter information to add to the special info (user-defined) lookup table.

Dialog options

User-defined
Maximum length is 50 characters.

Memo
This field is for comments. You may use up to 10000 characters.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Press Ctrl+Enter to add a new line to the memo field.

None of the user-defined fields are shown in field lists (for example when you want to 
search or print a report) before you have told CATraxx that it is in use. You do this by 
choosing Preferences from the File menu and selecting the fields you are using in the list 
box Show fields.



Dialog Format Groups

Each format item can be linked to one of the 14 format groups. CATraxx uses these format 
groups when creating the statistics report. Please note that an ordinary album and a 
double album must be separated, for example LP and Double LP. However, they can both 
be linked to the same format group.

Dialog options

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Transfer
Press this button to transfer the names of the format groups from another database.



Dialog Line-up

This dialog displays the persons that have been or are member of the selected group. This 
information can be used when you want to specify musicians that participate on a specific 
track. If you use this feature, you save a lot of time when you add new tracks.
You specify the persons that have been a member of this group, what instruments they 
play and what period they have been a member.

Dialog options

Close
Press this button to save any changes and close the dialog.

Add
Press this button to add a new person as a member of this group.

Remove
Press this button to remove the selected person as a member of this group.

Press Ctrl+I to specify what instruments the selected person plays and Ctrl+P to specify 
the period he or she was a member of the group.

As an example, open the sample database, SAMPLE.MDB, and check out Throwing 
Muses.



Dialog Line-up, Add Person

Use this dialog to specify the person you want to add as a member of the group. Use the 
text box to locate the person in the list (if he/she already is in the database). As you enter 
the name, the list is automatically updated. Please note that you must have activated this 
feature in the dialog Preferences (Data entry - Update position in lists automatically).
If not, enter the name and press the Search button.

Dialog options

OK
Press this button to choose the selected person.

Cancel
Press this button to close the dialog without selecting any person.

New
Press this button to add a new person. This person is added to the lookup table Person. 
This table is used by the following fields: Mixer, Musician, Producer and Songwriter. 
The name you have entered in the text box is automatically used. This makes it very 
easy to add a new person when you first have searched for this person and found out 
that he is not in the database.

Edit
Press this button to edit the selected person.

Delete
Press this button to delete the selected person.

Search
Press this button to search for the person where the last name begins with the value you
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Press Ctrl+1 to activate the text box.



Dialog Line-up, Period

In this dialog you specify in what period the person has been a member of the group. If he 
or she has been a member in several periods, specify each period separately.

Dialog options

From
Enter the year when the person became a member of the group.

To
Enter the year when the person quit the group. If he or she still is a member, let this text
box remain empty.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button the ignore any changes and close the dialog.



Dialog Line-up, Instrument

In this dialog you specify the instrument(s) the person plays. Use the text box to locate a 
instrument in the list (if it already is in the database). As you enter the name of the 
instrument, the list is automatically updated. Please note that you must have activated this
feature in the dialog Preferences (Data entry - Update position in lists automatically).
If not, enter the instrument and press the Search button.

Dialog options

List 1
This list displays all instruments in the database.

>
Press this button to move the selected instrument from list 1 to list 2. You may also 
press Ctrl+Right arrow.

<
Press this button to remove the selected instrument from list 2. You may also press 
Ctrl+Left arrow.

List 2
This list displays the instruments you have chosen.

Up
Press this button to move the selected instrument up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the instrument and then press Ctrl and hold the 
mouse-button down while you drag.

Down
Press this button to move the selected instrument down one line. You may also do this 
by pressing Ctrl+Down arrow, or click on the instrument and then press Ctrl and hold 
the mouse-button down while you drag.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

New
Press this button to add a new instrument. The instrument you have entered in the text 
box is automatically used. This makes it very easy to add a new instrument when you 
first have searched for this instrument and found out that it is not in the database.

Search
Press this button to search for the instrument where the name begins with the value you
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter a instrument in 
the text box.

Press Ctrl+1 to activate the text box.



Dialog Lookup Table Artist

You use this dialog to edit the lookup table Artist. Use the text box to locate the artist in the
list (if it already is in the database). As you enter the name, the list is automatically 
updated. Please note that you must have activated this feature in the dialog Preferences 
(Data entry - Update position in lists automatically). If not, enter the name and press
the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new artist. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new artist when you first have 
searched for this artist and found out that it is not in the database.

Edit
Press this button to edit the selected artist.

Delete
Press this button to delete the selected artist.

Search
Press this button to search for the artist where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Table Category

You use this dialog to edit the lookup table Category. Use the text box to locate the 
category in the list (if it already is in the database). As you enter the name, the list is 
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new category. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new category when you first have 
searched for this category and found out that it is not in the database.

Edit
Press this button to edit the selected category.

Delete
Press this button to delete the selected category.

Set default
Press this button to specify the selected category as a default value that is automatically
added to all new albums.

Search
Press this button to search for the category where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Table Company

You use this dialog to edit the lookup table Company. Use the text box to locate the 
company in the list (if it already is in the database). As you enter the name, the list is 
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new company. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new company when you first have 
searched for this company and found out that it is not in the database.

Edit
Press this button to edit the selected company.

Delete
Press this button to delete the selected company.

Set default
Press this button to specify the selected company as a default value that is 
automatically added to all new albums.

Search
Press this button to search for the company where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Table Condition

You use this dialog to edit the lookup table Condition. Use the text box to locate the 
condition in the list (if it already is in the database). As you enter the name, the list is 
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new condition. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new condition when you first have 
searched for this condition and found out that it is not in the database.

Edit
Press this button to edit the selected condition.

Delete
Press this button to delete the selected condition.

Set default
Press this button to specify the selected condition as a default value that is 
automatically added to all new albums.

Search
Press this button to search for the condition where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Table Country

You use this dialog to edit the lookup table Country. Use the text box to locate the country 
in the list (if it already is in the database). As you enter the name, the list is automatically 
updated. Please note that you must have activated this feature in the dialog Preferences 
(Data entry - Update position in lists automatically). If not, enter the name and press
the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new country. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new country when you first have 
searched for this country and found out that it is not in the database.

Edit
Press this button to edit the selected country.

Delete
Press this button to delete the selected country.

Set default
Press this button to specify the selected country as a default value that is automatically 
added to all new albums.

Search
Press this button to search for the country where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Table Distributor

You use this dialog to edit the lookup table Distributor. Use the text box to locate the 
distributor in the list (if it already is in the database). As you enter the name, the list is 
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new distributor. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new distributor when you first have
searched for this distributor and found out that it is not in the database.

Edit
Press this button to edit the selected distributor.

Delete
Press this button to delete the selected distributor.

Set default
Press this button to specify the selected distributor as a default value that is 
automatically added to all new albums.

Search
Press this button to search for the distributor where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Table Format

You use this dialog to edit the lookup table Format. Use the text box to locate the format in 
the list (if it already is in the database). As you enter the name, the list is automatically 
updated. Please note that you must have activated this feature in the dialog Preferences 
(Data entry - Update position in lists automatically). If not, enter the name and press
the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new format. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new format when you first have 
searched for this format and found out that it is not in the database.

Edit
Press this button to edit the selected format.

Delete
Press this button to delete the selected format.

Set default
Press this button to specify the selected format as a default value that is automatically 
added to all new albums.

Search
Press this button to search for the format where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Table Instrument

You use this dialog to edit the lookup table Instrument. Use the text box to locate the 
instrument in the list (if it already is in the database). As you enter the name, the list is 
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new instrument. The name you have entered in the text box is
automatically used. This makes it very easy to add a new instrument when you first 
have searched for this instrument and found out that it is not in the database.

Edit
Press this button to edit the selected instrument.

Delete
Press this button to delete the selected instrument.

Search
Press this button to search for the instrument where the name begins with the value you
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Table Label

You use this dialog to edit the lookup table Label. Use the text box to locate the label in the 
list (if it already is in the database). As you enter the name, the list is automatically 
updated. Please note that you must have activated this feature in the dialog Preferences 
(Data entry - Update position in lists automatically). If not, enter the name and press
the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new label. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new label when you first have 
searched for this label and found out that it is not in the database.

Edit
Press this button to edit the selected label.

Delete
Press this button to delete the selected label.

Set default
Press this button to specify the selected label as a default value that is automatically 
added to all new albums.

Search
Press this button to search for the label where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Table Person

You use this dialog to edit the lookup table Person. Please note that this table is used by 
the following field; Mixer, Musician, Producer and Songwriter. Use the text box to 
locate the person in the list (if he or she already is in the database). As you enter the 
name, the list is automatically updated. Please note that you must have activated this 
feature in the dialog Preferences (Data entry - Update position in lists automatically).
If not, enter the name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new person. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new person when you first have 
searched for this person and found out that he or she is not in the database.

Edit
Press this button to edit the selected person.

Delete
Press this button to delete the selected person.

Search
Press this button to search for the person where the last name begins with the value you
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Table Studio

You use this dialog to edit the lookup table Studio. Use the text box to locate the studio in 
the list (if it already is in the database). As you enter the name, the list is automatically 
updated. Please note that you must have activated this feature in the dialog Preferences 
(Data entry - Update position in lists automatically). If not, enter the name and press
the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new studio. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new studio when you first have 
searched for this studio and found out that it is not in the database.

Edit
Press this button to edit the selected studio.

Delete
Press this button to delete the selected studio.

Set default
Press this button to specify the selected studio as a default value that is automatically 
added to all new albums.

Search
Press this button to search for the studio where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.



Dialog Lookup Table User-defined

You use this dialog to edit the special info (user-defined) lookup table. Use the text box to 
locate the item in the list (if it already is in the database). As you enter the name, the list is
automatically updated. Please note that you must have activated this feature in the dialog 
Preferences (Data entry - Update position in lists automatically). If not, enter the 
name and press the Search button.

Dialog options

Close
Press this button to close the dialog.

New
Press this button to add a new item. The name you have entered in the text box is 
automatically used. This makes it very easy to add a new item when you first have 
searched for this item and found out that it is not in the database.

Edit
Press this button to edit the selected item.

Delete
Press this button to delete the selected item.

Set default
Press this button to specify the selected item as default a value that is automatically 
added to all new albums.

Search
Press this button to search for the item where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Report
Press this button to print a report.

Press Ctrl+1 to activate the text box.

None of the user-defined fields are shown in field lists (for example when you want to 
search or print out a report) before you have told CATraxx that it is in use. You do this by 
selecting File/Preferences and select the fields you are using in the list box called Show 
fields.



Dialog Transfer Lookup Tables

In this dialog you select the lookup tables you want to transfer to the open database.

Dialog options

OK
Press this button to start.

Cancel
Press this button to close the dialog.



Dialog Transfer Lookup Tables From

In this dialog you specify the database you want to transfer the lookup tables from.

Dialog options

Filename
Type the database you want to transfer the lookup tables from.

Directories
Select the directory where the database is located.

List files of type
Select file type. CATraxx's databases should always have the file extension MDB.

Drives
Select the drive where the database is located.



Dialog Adjust Value

This dialog lets you adjust the value for all ,or only the marked, albums.

Dialog options

Adjust by
Enter the percentage you want to change the value by.

Subset
Check this if you want to adjust the value for only the marked albums.

OK
Press this button to start.

Cancel
Press this button to cancel.



Dialog Artist Album

In this dialog you specify the artist(s) that has released the album. Up the 5 artists may be 
linked to the same album. Use the text box to locate the artist in the list (if it already is in 
the database). As you enter the name, the list is automatically updated. Please note that 
you must have activated this feature in the dialog Preferences (Data entry - Update 
position in lists automatically). If not, enter the name and press the Search button.

Dialog options

List 1
This list displays all artists in the database.

>
Press this button to move the selected artist from list 1 to list 2. You may also press 
Ctrl+Right arrow.

<
Press this button to remove the selected artist from list 2. You may also press Ctrl+Left 
arrow.

List 2
This list displays the artists you have chosen.

Up
Press this button to move the selected artist up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the artist and then press Ctrl and hold the mouse-
button down while you drag.

Down
Press this button to move the selected artist down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the artist and then press Ctrl and hold the 
mouse-button down while you drag.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

New
Press this button to add a new artist. The artist you have entered in the text box is 
automatically used. This makes it very easy to add a new artist when you first have 
searched for this artist and found out that it is not in the database.

Search
Press this button to search for the artist where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter a artist in the 
text box.

Press Ctrl+1 to activate the text box.



Dialog Load Cover

In this dialog you specify the bitmap you want to load and store in the cover field. Only 
bitmaps are currently supported.

Dialog options

Filename
Type the name of the file.

Directories
Select the directory where the files is located.

List files of type
Select file type (bitmaps should always have the extension BMP).

Drives
Select the drive where the file is located.



Dialog Total Value

This dialog displays the total value and the change in value.



Dialog View Artist - Edit 

Use this dialog to edit artist for several tracks at the same time.

Dialog options

Artist
This list displays the artists you have specified.

Tracks
This list displays all tracks on the album. Select the tracks you want to change artist on 
by pressing Ctrl while you click. To select several tracks, click on the first track you want
to select, and drag the mouse-pointer to the last track you want to select.

Keep existing
Use this check box to tell CATraxx whether to delete the artists that already are added or
not. If you uncheck Keep existing CATraxx deletes all artists currently added to the 
tracks you want to edit! Let it remain checked if you want to keep the existing artists.

Close
Press this button to close the dialog. If you have made any changes, you are asked if 
you want to save them.

Save
Press this button to save any changes.

Get
Press this button to get the artists that are already added to the tracks on this album.



Dialog View Artist - Tracks

This dialog displays all the tracks that the selected artist performs on.



Dialog View Information From Tracks - Artist

This dialog displays all artists that performs on the tracks on the active album.

Dialog options

Close
Press this button to close the dialog.

View tracks
Press this button to look at the tracks the selected artist performs on.

Edit
Press this button to edit artist for several tracks at the same time.



Dialog View Information From Tracks - Mixer

This dialog displays all mixers that have mixed songs the active album.

Dialog options

Close
Press this button to close the dialog.

View tracks
Press this button to look at the tracks the selected mixer has mixed.

Edit
Press this button to edit mixer for several tracks at the same time.



Dialog View Information From Tracks - Musician

This dialog displays all musicians that play on the active album.

Dialog options

Close
Press this button to close the dialog.

View tracks
Press this button to look at the tracks the selected musician plays on.

Edit
Press this button to edit musician for several tracks at the same time.



Dialog View Information From Tracks - Producer

This dialog displays all producers that have produced tracks on the active album.

Dialog options

Close
Press this button to close the dialog.

View tracks
Press this button to look at the tracks the selected producer has produced.

Edit
Press this button to edit producer for several tracks at the same time.



Dialog View Information From Tracks - Songwriter

This dialog displays all songwriters that have written songs the active album.

Dialog options

Close
Press this button to close the dialog.

View tracks
Press this button to look at the tracks the selected songwriter has written.

Edit
Press this button to edit songwriter for several tracks at the same time.



Dialog View Information From Tracks - Studio

This dialog displays all studios the tracks on the activate album are recorded in.

Dialog options

Close
Press this button to close the dialog.

View tracks
Press this button to look at the tracks recorded in the selected studio.

Edit
Press this button to edit studio for several tracks at the same time.



Dialog View Mixer - Edit

Use this dialog to edit mixer for several tracks at the same time.

Dialog options

Mixer
This list displays the mixers you have specified.

Tracks
This list displays all tracks on the album. Select the tracks you want to change mixer on 
by pressing Ctrl while you click. To select several tracks, click on the first track you want
to select, and drag the mouse-pointer to the last track you want to select.

Keep existing
Use this check box to tell CATraxx whether to delete the mixers that already are added 
or not. If you uncheck Keep existing CATraxx deletes all mixers currently added to the 
tracks you want to edit! Let it remain checked if you want to keep the existing mixers.

Close
Press this button to close the dialog. If you have made any changes, you are asked if 
you want to save them.

Save
Press this button to save any changes.

Get
Press this button to get the mixers that are already added to the tracks on this album.



Dialog View Mixer - Tracks

This dialog displays all the tracks that the selected mixer has mixed.



Dialog View Musician - Edit

Use this dialog to edit musician for several tracks at the same time.

Dialog options

Musician
This list displays the musicians you have specified.

Tracks
This list displays all tracks on the album. Select the tracks you want to change musician 
on by pressing Ctrl while you click. To select several tracks, click on the first track you 
want to select, and drag the mouse-pointer to the last track you want to select.

Keep existing
Use this check box to tell CATraxx whether to delete the musicians that already are 
added or not. If you uncheck Keep existing CATraxx deletes all musicians currently 
added to the tracks you want to edit! Let it remain checked if you want to keep the 
existing musicians.

Close
Press this button to close the dialog. If you have made any changes, you are asked if 
you want to save them.

Save
Press this button to save any changes.

Get
Press this button to get the musicians that are already added to the tracks on this 
album.



Dialog View Musician - Tracks

This dialog displays all the tracks that the selected musician plays on.



Dialog View Producer - Edit

Use this dialog to edit producer for several tracks at the same time.

Dialog options

Producer
This list displays the producers you have specified.

Tracks
This list displays all tracks on the album. Select the tracks you want to change producer 
on by pressing Ctrl while you click. To select several tracks, click on the first track you 
want to select, and drag the mouse-pointer to the last track you want to select.

Keep existing
Use this check box to tell CATraxx whether to delete the producers that already are 
added or not. If you uncheck Keep existing CATraxx deletes all producers currently 
added to the tracks you want to edit! Let it remain checked if you want to keep the 
existing producers.

Close
Press this button to close the dialog. If you have made any changes, you are asked if 
you want to save them.

Save
Press this button to save any changes.

Get
Press this button to get the producers that are already added to the tracks on this 
album.



Dialog View Producer - Tracks

This dialog displays all the tracks that the selected producer has produced.



Dialog View Songwriter - Edit

Use this dialog to edit songwriter for several tracks at the same time.

Dialog options

Songwriter
This list displays the songwriters you have specified.

Tracks
This list displays all tracks on the album. Select the tracks you want to change 
songwriter on by pressing Ctrl while you click. To select several tracks, click on the first 
track you want to select, and drag the mouse-pointer to the last track you want to 
select.

Keep existing
Use this check box to tell CATraxx whether to delete the songwriters that already are 
added or not. If you uncheck Keep existing CATraxx deletes all songwriters currently 
added to the tracks you want to edit! Let it remain checked if you want to keep the 
existing songwriters.

Close
Press this button to close the dialog. If you have made any changes, you are asked if 
you want to save them.

Save
Press this button to save any changes.

Get
Press this button to get the songwriters that are already added to the tracks on this 
album.

Please note that it is not possible to specify who wrote the music and who wrote the lyrics 
in this dialog.



Dialog View Songwriter - Tracks

This dialog displays all the tracks that the selected songwriter has written.



Dialog View Studio - Edit

Use this dialog to edit studio for several tracks at the same time.

Dialog options

Studio
This list displays the studios you have specified.

Tracks
This list displays all tracks on the album. Select the tracks you want to change studio on 
by pressing Ctrl while you click. To select several tracks, click on the first track you want
to select, and drag the mouse-pointer to the last track you want to select.

Keep existing
Use this check box to tell CATraxx whether to delete the studios that already are added 
or not. If you uncheck Keep existing CATraxx deletes all studios currently added to the 
tracks you want to edit! Let it remain checked if you want to keep the existing studios.

Close
Press this button to close the dialog. If you have made any changes, you are asked if 
you want to save them.

Save
Press this button to save any changes.

Get
Press this button to get the studios that are already added to the tracks on this album.



Dialog View Studio - Tracks

This dialog displays all the tracks recorded in the selected studio.



Dialog Active Track

The window title indicates what album the track is located on (Artist, Album title and 
Format). The tracks position on the album is also shown. With position we mean on what 
item and what side the track is located. If the track is number 2 on side A, (A2) is shown, 
and if the track is number 4 on side B item 2, (2-B4) is shown. The first track you add is 
always track 1 on side A. When you are ready to add track 1 on side B (does not apply to 
CDs!), choose Change side. Because no other tracks are added to this side, CATraxx asks 
whether you want to add a new track or a copy of the active track. This corresponds to the 
buttons New and Copy. If you have added a track to the wrong position (for example 
swapped track 4 and 5), simply choose Change order and select the right track position.
When you add the first track on the album, the dialog Default Information is shown. Here 
you enter information that is relevant to all tracks (or most of them). This is usually true for
Artist, Songwriter, Producer, Mixer, Studio, Musician and Instrument. The 
information you enter in this dialog box is automatically added to all new tracks. This way 
you can save a lot of time. Please note that this applies only when you choose to add a 
new track (New). If you choose to make a copy of the active track (Copy), CATraxx ignores 
this information.
CATraxx can automatically add musicians and instruments based on the artist(s) 
performing on the track and when the track was recorded. You must then have specified 
line-up (that is, members of the group) for these artists. To specify line-up, choose Artist 
from the Lookup menu, select artist, press the Edit button and then press the Line-up 
button. Enter the musicians that have been a members of the group, what instruments 
they played and in what period they were members (as an example, open the sample 
database, SAMPLE.MDB, and check out Throwing Muses). When you want to add 
musicians, press the Automatic button, specify recording year and let CATraxx add the 
relevant musicians and instruments.
Please note that the persons linked to Songwriter, Producer, Mixer and Musician all 
come from the lookup table Person. As a result you can use standard drag-and-drop 
techniques to transfer names between these lists. Because Songwriter / Producer / 
Mixer and Musician are not shown at the same time, you must drag the pointer over the 
title Standard or Musician to make visible the list you want to drop the names on.
CATraxx can automatically read the track length for all tracks on the album. Add first all 
track (artists, song titles and so on), insert the CD into the CD-ROM player and press the 
Read length button.

Dialog options

Song title
Enter the title of the song. Maximum length is 75 characters.

Artist
The name of the artist that performs on the track.

Length
The length of the track in minutes and seconds. If you have a CD-ROM drive (and are 
adding tracks from a CD!) you do not need to enter this manually, simply insert the CD 
into the CD-ROM drive and press the Read length button. CATraxx reads the length of 
all tracks on the CD. Please note that you need to add all tracks (song title, artist and so 
on) before you press this button. If you want to manually enter the length, you must use
the format mm:ss, where m is minutes and s is seconds; for example 03:43.



Recorded
The year when the song was recorded.

Live
Check this box if the song is a live recording.

Instrumental
Check this box if the song is an instrumental.

Mono/Stereo
Specify whether the recording is in mono or stereo.

Songwriter
Specify the songwriter(s). By default you can specify who wrote the music and who 
wrote the lyrics. If you do not want to do this, choose Preferences from the File menu 
and uncheck Data entry - Songwriter - Specify music/lyrics.

Studio
Specify the studio(s) where the song was recorded.

Producer
Specify the producer(s).

Mixer
Specify the mixer(s).

Musician
Here you specify the musicians and what instruments they play. CATraxx can 
automatically add musicians and instruments based on the artist(s) performing on the 
track and when the track was recorded. You must then have specified line-up (that is, 
members of the group) for these artists. To specify line-up, choose Artist from the 
Lookup menu, select artist, press the Edit button and then press the Line-up button. 
Enter the persons that have been a member of the group, what instruments they played
and in what period they were members (as an example, open the sample database, 
SAMPLE.MDB, and check out Throwing Muses). When you want to add musicians, 
press the Automatic button, specify recording year and let CATraxx add the relevant 
musicians and instruments.

Memo
This field is for comments. Maximum length is 10.000 characters.

User-defined 14
This is a text field with a maximum length of 50 characters.

User-defined 15
This is a text field with a maximum length of 50 characters.

User-defined 16
This field is linked to a lookup table. It has a maximum length of 50 characters. Type the 
value or select it from the drop-down list. Choose User-defined/User-defined 16 from 
the Lookup menu to edit this list

User-defined 17
This field is linked to a lookup table. It has a maximum length of 50 characters. Type the 
value or select it from the drop-down list. Choose User-defined/User-defined 17 from 
the Lookup menu to edit this list

User-defined 18
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).

User-defined 19
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).



User-defined 20
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).

Press this button to go to previous track.

Press this button to go to next track.

Press this button the mark the track, or release it to unmark the track.
Close

Press the button to close the dialog.
New

Press this button to add a new track. A new track is always added to the active side, and
the default information are automatically added. When you are ready to add track 1 on 
side B (does not appliy to CDs!), press the Change side button.

Copy
Press this button to add a copy of the active track. A new track is always added to the 
active side.

Change side
Press this button to change the active side, for example from side A to side B, or from 
item 1 to item 2.

Change order
Press this button if you have added a track to wrong position (for example swapped 
track 4 and 5). Specify new item, side and song number.

Default information
Press this button to enter information that is relevant to all tracks (or most of them). 
This information is automatically added to all new tracks.

Read length
Press this button to read the track length for all tracks on the album. Add first all track 
(artists, song titles and so on), insert the CD into the CD-ROM player and then press this 
button.

Print
Press this button to print the active track using the full report layout.

You can use standard drag-and-drop technique to transfer names between these lists: 
Songwriter, Mixer, Producer and Musician.

The following shortcuts are available:
· Ctrl+A - add Artist
· Ctrl+I - Add Mixer
· Ctrl+M - Mark track
· Ctrl+O - Add Songwriter
· Ctrl+P - Add Producer
· Ctrl+S - Add Studio
· Ctrl+U - Add Musician



Dialog Add Musician

Use this dialog to specify the person you want to add as a musician on the selected track. 
Use the text box to locate the person in the list (if he/she already is in the database). As 
you enter the name, the list is automatically updated. Please note that you must have 
activated this feature in the dialog Preferences (Data entry - Update position in lists 
automatically). If not, enter the name and press the Search button.

Dialog options

OK
Press this button to choose the selected person.

Cancel
Press this button to close the dialog without selecting any person.

New
Press this button to add a new person. This person is added to the lookup table Person. 
This table is used by the following fields: Mixer, Musician, Producer and Songwriter. 
The name you have entered in the text box is automatically used. This makes it very 
easy to add a new person when you first have searched for this person and found out 
that he is not in the database.

Edit
Press this button to edit the selected person.

Delete
Press this button to delete the selected person.

Search
Press this button to search for the person where the last name begins with the value you
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter the name in the 
text box.

Press Ctrl+1 to activate the text box.



Dialog Artist Track

In this dialog you specify the artist(s) that performs on the track. Up the 5 artists may be 
linked to the same track. Usually the artist is the same as on the album, but on 
compilations the artist may differ from track to track. Use the text box to locate the artist in
the list (if it already is in the database). As you enter the name, the list is automatically 
updated. Please note that you must have activated this feature in the dialog Preferences 
(Data entry - Update position in lists automatically). If not, enter the name and press
the Search button.

Dialog options

List 1
This list displays all artists in the database.

>
Press this button to move the selected artist from list 1 to list 2. You may also press 
Ctrl+Right arrow.

<
Press this button to remove the selected artist from list 2. You may also press Ctrl+Left 
arrow.

List 2
This list displays the artists you have chosen.

Up
Press this button to move the selected artist up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the artist and then press Ctrl and hold the mouse-
button down while you drag.

Down
Press this button to move the selected artist down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the artist and then press Ctrl and hold the 
mouse-button down while you drag.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

New
Press this button to add a new artist. The artist you have entered in the text box is 
automatically used. This makes it very easy to add a new artist when you first have 
searched for this artist and found out that it is not in the database.

Search
Press this button to search for the artist where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter a artist in the 
text box.

Press Ctrl+1 to activate the text box.



Dialog Change Order

In this dialog you change the order of the tracks. If you have added a track to wrong 
position (for example swapped track 4 and 5), you fix it in this dialog. You specify item, side
and song number.

Dialog options

Item
Specify what item the track is located on. You only do this for albums that consists of 
more the one item (double albums, compilation boxes etc).

Side
Specify if the track is located on side A or side B (only albums with two sides like LPs, 
vinyl-singles or cassettes).

Song no
Enter the song number.

OK
Press this dialog to change the track order and close the dialog.

Cancel
Press this dialog to close the dialog without changing the track order.



Dialog Change Side

In this dialog you specify what side to activate.

Dialog options

Item
Specify what item to activate. You do this only for albums that consists of more the one 
item (double albums, compilation boxes etc).

Side
Specify either side A or side B (only albums with two sides like LPs, vinyl-singles or 
Cassettes).

OK
Press this button to active the specified side.

Cancel
Press this button to close the dialog without changing side.



Dialog Change Side - New Track

In this dialog you specify whether you want to add a new track or a copy of the active 
track. This corresponds to the buttons New and Copy.

Dialog options

New
Press this button to add a new empty track.

Copy
Press this button to add a new track that is a copy of the active track.

Cancel
Press this button to close the dialog.



Dialog Default Information

In this dialog you enter information that is relevant to all tracks (or most of them). This is 
usually true for Artist, Songwriter, Producer, Mixer, Studio, Musician and 
Instrument. The information you enter in this dialog is automatically added to all new 
tracks you add. This way you can save a lot of time. Please note that this applies only when
you choose to add a new track (New). If you choose to make a copy of the active track 
(Copy), CATraxx ignores this information.
Please note that the persons used by Songwriter, Producer, Mixer and Musician all 
come from the lookup table Person. As a result you can use standard drag-and-drop 
technique to transfer names between these lists. Because Songwriter/Producer/Mixer 
and Musician are not shown at the same time you must drag the mouse pointer over the 
Standard tab or the Musician tab to make the list you want to drop the names on is 
visible.

Dialog options

Artist
The name of the artist that performs on the track.

Recorded
The year when the song was recorded.

Live
Check this box if the song is a live recording.

Instrumental
Check this box if the song is an instrumental.

Mono/Stereo
Specify whether the recording is in mono or stereo.

Songwriter
Specify the songwriter(s). By default you can specify who wrote the music and who 
wrote the lyrics. If you do not want to do this, choose Preferences from the File menu 
and uncheck Data entry - Songwriter - Specify music/lyrics.

Studio
Specify the studio(s) where the song was recorded.

Producer
Specify the producer(s).

Mixer
Specify the mixer(s).

Musician
Here you specify the musicians and what instruments they play. CATraxx can 
automatically add musicians and instruments based on the artist(s) performing on the 
track and when the track was recorded. You must then have specified line-up (that is, 
members of the group) for these artists. To specify line-up, choose Artist from the 
Lookup menu, select artist, press the Edit button and then press the Line-up button. 
Enter the persons that have been a member of the group, what instruments they played
and in what period they were members (as an example, open the sample database, 
SAMPLE.MDB, and check out Throwing Muses). When you want to add musicians, 
press the Automatic button, specify recording year and let CATraxx add the relevant 
musicians and instruments.

Memo



This field is for comments. Maximum length is 10.000 characters.
User-defined 14

This is a text field with a maximum length of 50 characters.
User-defined 15

This is a text field with a maximum length of 50 characters.
User-defined 16

This field is linked to a lookup table. It has a maximum length of 50 characters. Type the 
value or select it from the drop-down list. Choose User-defined/User-defined 16 from 
the Lookup menu to edit this list

User-defined 17
This field is linked to a lookup table. It has a maximum length of 50 characters. Type the 
value or select it from the drop-down list. Choose User-defined/User-defined 17 from 
the Lookup menu to edit this list

User-defined 18
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).

User-defined 19
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).

User-defined 20
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).

OK
Press this button to save the information and close the dialog.

Cancel
Press this button to close the dialog.

Clear
Press this button to clear all fields.

The following shortcuts are available:
· Ctrl+A - add Artist
· Ctrl+I - Add Mixer
· Ctrl+O - Add Songwriter
· Ctrl+P - Add Producer
· Ctrl+S - Add Studio
· Ctrl+U - Add Musician



Dialog Instrument

In this dialog you specify the instruments the selected musician plays. Use the text box to 
locate the instrument in the list (if it already is in the database). As you enter the name, 
the list is automatically updated. Please note that you must have activated this feature in 
the dialog Preferences (Data entry - Update position in lists automatically). If not, 
enter the name and press the Search button.

Dialog options

List 1
This list displays all instrument in the database.

>
Press this button to move the selected instrument from list 1 to list 2. You may also 
press Ctrl+Right arrow.

<
Press this button to remove the selected instrument from list 2. You may also press 
Ctrl+Left arrow.

List 2
This list displays the instruments you have chosen.

Up
Press this button to move the selected instrument up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the instrument and then press Ctrl and hold the 
mouse-button down while you drag.

Down
Press this button to move the selected instrument down one line. You may also do this 
by pressing Ctrl+Down arrow, or click on the instrument and then press Ctrl and hold 
the mouse-button down while you drag.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

New
Press this button to add a new instrument. The instrument you have entered in the text 
box is automatically used. This makes it very easy to add a new instrument when you 
first have searched for this instrument and found out that it is not in the database.

Search
Press this button to search for the instrument where the name begins with the value you
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter a artist in the 
text box.

Press Ctrl+1 to activate the text box.



Dialog Mixer

In this dialog you specify the persons who have mixed the song. Use the text box to locate 
the person in the list (if he or she already is in the database). As you enter the name, the 
list is automatically updated. Please note that you must have activated this feature in the 
dialog Preferences (Data entry - Update position in lists automatically). If not, enter 
the name and press the Search button.

Dialog options

List 1
This list displays all persons in the database.

>
Press this button to move the selected person from list 1 to list 2. You may also press 
Ctrl+Right arrow.

<
Press this button to remove the selected person from list 2. You may also press 
Ctrl+Left arrow.

List 2
This list displays the persons you have chosen.

Up
Press this button to move the selected person up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the person and then press Ctrl and hold the 
mouse-button down while you drag.

Down
Press this button to move the selected person down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the person and then press Ctrl and hold the 
mouse-button down while you drag.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

New
Press this button to add a new person. The person you have entered in the text box is 
automatically used. This makes it very easy to add a new person when you first have 
searched for this person and found out that he or she is not in the database.

Search
Press this button to search for the person where the last name begins with the value you
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter a artist in the 
text box.

Press Ctrl+1 to activate the text box.



Dialog Musicians

In this dialog you specify the musicians and what instruments they play. CATraxx can 
automatically add musicians and instruments based on the artist(s) performing on the 
track and when the track was recorded. You must then have specified line-up (that is, 
members of the group) for the artists performing on the track.

Dialog options

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Add
Press this button to add a new person as a musician on the selected track.

Remove
Press this button to remove the selected person as a musician on the selected track.

Automatic
Press this button to add musicians and instruments based on the line-up for this artist. 
To specify line-up, choose Artist from the Lookup menu, select artist, press the Edit 
button and then press the Line-up button.

Press Ctrl+I to specify instruments.



Dialog Producer

In this dialog you specify the persons who have produced the song. Use the text box to 
locate the person in the list (if he or she already is in the database). As you enter the 
name, the list is automatically updated. Please note that you must have activated this 
feature in the dialog Preferences (Data entry - Update position in lists automatically).
If not, enter the name and press the Search button.

Dialog options

List 1
This list displays all persons in the database.

>
Press this button to move the selected person from list 1 to list 2. You may also press 
Ctrl+Right arrow.

<
Press this button to remove the selected person from list 2. You may also press 
Ctrl+Left arrow.

List 2
This list displays the persons you have chosen.

Up
Press this button to move the selected person up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the person and then press Ctrl and hold the 
mouse-button down while you drag.

Down
Press this button to move the selected person down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the person and then press Ctrl and hold the 
mouse-button down while you drag.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

New
Press this button to add a new person. The person you have entered in the text box is 
automatically used. This makes it very easy to add a new person when you first have 
searched for this person and found out that he or she is not in the database.

Search
Press this button to search for the person where the last name begins with the value you
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter a artist in the 
text box.

Press Ctrl+1 to activate the text box.



Dialog Songwriter

In this dialog you specify the persons who have written the song. Use the text box to locate
the person in the list (if he or she already is in the database). As you enter the name, the 
list is automatically updated. Please note that you must have activated this feature in the 
dialog Preferences (Data entry - Update position in lists automatically). If not, enter 
the name and press the Search button.

Dialog options

List 1
This list displays all persons in the database.

>
Press this button to move the selected person from list 1 to list 2. You may also press 
Ctrl+Right arrow.

<
Press this button to remove the selected person from list 2. You may also press 
Ctrl+Left arrow.

List 2
This list displays the persons you have chosen.

Up
Press this button to move the selected person up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the person and then press Ctrl and hold the 
mouse-button down while you drag.

Down
Press this button to move the selected person down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the person and then press Ctrl and hold the 
mouse-button down while you drag.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

New
Press this button to add a new person. The person you have entered in the text box is 
automatically used. This makes it very easy to add a new person when you first have 
searched for this person and found out that he or she is not in the database.

Search
Press this button to search for the person where the last name begins with the value you
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter a artist in the 
text box.

Press Ctrl+1 to activate the text box.



Dialog Studio

In this dialog you specify where the song is recorded. Use the text box to locate the studio 
in the list (if it already is in the database). As you enter the name, the list is automatically 
updated. Please note that you must have activated this feature in the dialog Preferences 
(Data entry - Update position in lists automatically). If not, enter the name and press
the Search button.

Dialog options

List 1
This list displays all studios in the database.

>
Press this button to move the selected studio from list 1 to list 2. You may also press 
Ctrl+Right arrow.

<
Press this button to remove the selected studio from list 2. You may also press 
Ctrl+Left arrow.

List 2
This list displays the studios you have chosen.

Up
Press this button to move the selected studio up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the studio and then press Ctrl and hold the mouse-
button down while you drag.

Down
Press this button to move the selected studio down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the studio and then press Ctrl and hold the 
mouse-button down while you drag.

OK
Press this button to save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

New
Press this button to add a new studio. The studio you have entered in the text box is 
automatically used. This makes it very easy to add a new studio when you first have 
searched for this studio and found out that it is not in the database.

Search
Press this button to search for the studio where the name begins with the value you 
specify. Please note that you only need to use this command if you have not checked 
Data entry - Update position in lists automatically in the dialog Preferences. If you
have checked this option the list is updated automatically as you enter a artist in the 
text box.

Press Ctrl+1 to activate the text box.



Dialog View Tracks

This dialog displays the tracks without regard for what album they are located on. The 
window's size and position is automatically saved, and is used the next time you activate it.
Choose Edit from the Track menu to edit the selected track.



Dialog Advanced Search

In this dialog you specify the search criterion you want to base the search on. You can use 
up to 12 fields. You can group the fields in different ways. The search criterion can be saved
to a file for later use. You enter information about the sub-criterion you want to include in 
the query in the same way as you do when you use the simple search. You may use the 
logical operator Or to link two fields. Press the button named OR to do this. Two fields that 
are placed on two lines next to each other are grouped by the logical operator AND. You 
add parentheses by clicking on either ( or ).

Dialog options

Add field
Press this button to add a new field (field, operator and value, also called a sub-
criterion).

Edit
Press this button the edit the selected sub-criterion.

Remove
Press this button to remove the selected sub-criterion.

OR
Press this button to add the Or logical operator.

(
Press this button to add a left parenthesis.

)
Press this button to add a right parenthesis.

Up
Press this button to move the selected sub-criterion up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the sub-criterion and then press Ctrl and hold the 
mouse-button down while you drag.

Down
Press this button to move the selected sub-criterion down one line. You may also do this 
by pressing Ctrl+Down arrow, or click on the sub-criterion and then press Ctrl and 
hold the mouse-button down while you drag.

Search subset
Check this if you want to search only the marked albums or tracks.

Show all
Check this if you want CATraxx to mark all albums or tracks found during the search and 
show them (that is, activate the View Subset or View Tracks command). Uncheck this
if you want CATraxx to only show the first album or track found. Then select 
Search/Show Next to show the next.

Show albums
Check this if you want CATraxx to show what albums the tracks found during the search 
are located on.

OK
Press this button to execute the search.

Cancel
Press this button the close the dialog.

Open



Press this button to open a saved search criterion.
Save

Press this button to save the search criterion.
Save as

Press this button to save the search criterion under a different name.

CATraxx does not distinguish between upper and lower case characters when searching.

Please note that all saved search criterion also can be used as a filter in reports.



Dialog Advanced Search - Sub-criterion

In this dialog you specify the field you want to search in and the value to search for in this 
part of the search criterion. You must also specify the operator that is used to compare the 
value of the field with the value you specified (for example contains, less than or 
between). 
CATraxx supports use of wildcards (? and ). It is only possible to use wildcards in relation 
with the operators Contains and Does not contain. A wildcard is a character that 
substitutes for and enables a match by any of the characters or set of characters in its 
place. The question mark can be thought of as a special character that means replace me 
with any character you like. The asterisk can be thought of as a special character that 
means replace me with none or more occurrences of any character you like.

Dialog options

Field values
Press this button to select a field value from the list (this is the same list shown when 
you choose Show Field Values from the Search menu).

OK
Press this button to activate the sub-criterion.

Cancel
Press this button the close the dialog.

CATraxx does not distinguish between upper and lower case characters when searching.



Dialog Cross-references

In this dialog you can create cross-references between albums, tracks, artists, songwriters, 
musicians, instruments etc. This is an extremely flexible way to search and query data. The
result is shown immediately on the screen. You may want to print a report or execute a 
search based on the cross references.
It is possible to create cross reference based on up to five fields. The dialog box has five list
boxes that show the result of the cross references. 
Placed right over every list are two drop-down lists. You select field from the left list and 
operator from the right list:

= Is equal to
>= Is greater then or equal to
<= Is less than or equal to

The operator is by default set to =, as this is the most likely choice. 
Please note that in many cases if you want to execute a search based on the cross 
references, you may want to set the operator to >=. This is because CATraxx compares the
field value with the operator when the search is executed. For example, if you create a 
cross reference between an artist and all tracks with this artist, and you want to search for 
all these tracks, you need to select the first track and then select the operator >= before 
the search is executed. If you do not do this, CATraxx will think you want to search for 
exactly the track that is selected in the list (since the operator was set to =).

See also: Cross-references 1 - Artist album -> Album title 
Cross-references 2 - Artist track -> Producer -> Song title 
Cross-references 3 - Instrument -> Musician -> Album title 

Menu options

File/New
Close all cross-references and clear all lists.

File/Open
Open saved cross-references.

File/Save
Save cross-references.

File/Save as
Save cross-references under a different name.

File/Close
Close the dialog.

Search/Execute
Execute the search.

Search/Search subset
Check this if you want to search only the marked albums or tracks.

Search/Show all
Check this if you want CATraxx to mark all albums or tracks found during the search and 
show them (that is, activate the View Subset or View Tracks command). Uncheck this



if you want CATraxx to only show the first album or track found. Then choose Show 
Next from the Search menu to show the next.

Search/Show albums
Check this if you want CATraxx to show what albums the tracks found during the search 
are located on.

Report
Press this button to print a report.



Dialog Find Album

Use this dialog to search for albums. This is the easiest way to search. You can search for 
both albums and tracks. CATraxx includes only the fields you have entered values for. 
Please note that you need to enter two values for some of the fields. For example, if you 
want to search for albums with a playing time between 40 and 60 minutes, you enter 
040:00 and 060:00 in the text boxes for playing time.

Dialog options

Search subset
Check this if you want to search only the marked albums.

Show all
Check this if you want CATraxx to mark all albums found during the search and show 
them (that is, activate the View Subset command). Uncheck this if you want CATraxx to
only show the first album found. Then choose Show Next from the Search menu to 
show the next.

OK
Press this button to execute the search.

Cancel
Press this button the close the dialog.



Dialog Find Track

Use this dialog to search for tracks. This is the easiest way to search. You can search for 
both albums and tracks. CATraxx includes only the fields you have entered values for. 
Please note that you need to enter two values for some of the fields. For example, if you 
want to search for tracks with a length between 2 and 4 minutes, you enter 002:00 and 
04:00 in the text boxes for length.
See also: Search For Tracks - Show All 

Dialog options

Search subset
Check this if you want to search only the marked tracks.

Show all
Check this if you want CATraxx to mark all tracks found during the search and show 
them (that is, activate the View Tracks command). Uncheck this if you want CATraxx to
only show the first track found. Then choose Show Next from the Search menu to 
show the next.

Show albums
Check this if you want CATraxx to show what albums the tracks found during the search 
are located on.

OK
Press this button to execute the search.

Cancel
Press this button the close the dialog.



Dialog Search Result

This dialog displays the albums or tracks that were found during the last search.

Dialog options

Go To
Press this button to go to the selected album or track.

Close
Press this button to close the dialog.



Dialog Show Field Values

In this dialog you specify the field you want to search in with the drop-down list. A All 
unique values are shown in the list box. Select the value you want to search for and choose
OK. The number of occurrences for each value is also shown. This might be very useful for 
statistical purposes.

Dialog options

OK
Press this button to execute the search.

Cancel
Press this button the close the dialog.

Report
Press this button to print a report.

Search
Press this button to search for the first item in the list that begins with the value you 
specify.

Only year
Check this if you want to ignore day and month in date fields.

Sort
Value Sorted by the field value (column 2).
Number Sorted by the number of occurrences (column 1).

Search subset
Check this if you want to search only the marked albums or tracks.

Show all
Check this if you want CATraxx to mark all albums or tracks found during the search and 
show them (that is, activate the View Subset or View Tracks command). Uncheck this
if you want CATraxx to only show the first album or track found. Then choose Show 
Next from the Search menu to show the next.

Show albums
Check this if you want CATraxx to show what albums the tracks found during the search 
are located on.



Dialog Show Field Values - Select Value

This dialog displays the values of the selected field. Instead of entering this yourself, you 
select it from the list.

Dialog options

OK
Press this button to activate the selected value.

Cancel
Press this button the close the dialog.

Report
Press this button to print a report.

Search
Press this button to search for the first item in the list that begins with the value you 
specify.

Only year
Check this if you want to ignore day and month in date fields.

Sort
Value Sorted by the field value (column 2).
Number Sorted by the number of occurrences (column 1).



Dialog Simple Search

In this dialog you specify the field you want to search in and the value to search for. You 
must also specify the operator that is used to compare the value of the field with the value 
you specified (for example contains, less than or between). 
CATraxx supports use of wildcards (? and ). It is only possible to use wildcards in relation 
with the operators Contains and Does not contain. A wildcard is a character that 
substitutes for and enables a match by any of the characters or set of characters in its 
place. The question mark can be thought of as a special character that means replace me 
with any character you like. The asterisk can be thought of as a special character that 
means replace me with none or more occurrences of any character you like.

Dialog options

Field values
Press this button to select a field value from the list (this is the same list shown when 
you choose Show Field Values from the Search menu).

Search subset
Check this if you want to search only the marked albums or tracks.

Show all
Check this if you want CATraxx to mark all albums or tracks found during the search and 
show them (that is, activate the View Subset or View Tracks command). Uncheck this
if you want CATraxx to only show the first album or track found. Then choose Show 
Next from the Search menu to show the next.

Show albums
Check this if you want CATraxx to show what albums the tracks found during the search 
are located on.

OK
Press this button to execute the search.

Cancel
Press this button the close the dialog.

CATraxx does not distinguish between upper and lower case characters when searching.



Dialog Special Search - Artist Album

Use this dialog to search for albums released by either one of or both the artists you 
specify.
Select artist from the drop-down lists. If you want to search for albums released by both the
artists, select AND. If you want to search for tracks released by only one of the artists, 
select OR.

Dialog options

Search subset
Check this if you want to search only the marked albums.

Show all
Check this if you want CATraxx to mark all albums found during the search and show 
them (that is, activate the View Tracks command). Uncheck this if you want CATraxx to
only show the first album found. Then choose Show Next from the Search menu to 
show the next.

OK
Press this button to execute the search.

Cancel
Press this button the close the dialog.



Dialog Special Search - Artist Track

Use this dialog to search for tracks performed by either one of or both the artists you 
specify. For example, you may want to search for tracks performed by both Neil Young 
and Crazy Horse.
Select artist from the drop-down lists. If you want to search for tracks where both the 
artists perform, select AND. If you want to search for tracks where only one of the artists 
perform, select OR.

Dialog options

Search subset
Check this if you want to search only the marked tracks.

Show all
Check this if you want CATraxx to mark all tracks found during the search and show 
them (that is, activate the View Tracks command). Uncheck this if you want CATraxx to
only show the first track found. Then choose Show Next from the Search menu to 
show the next.

Show albums
Check this if you want CATraxx to show what albums the tracks found during the search 
are located on.

OK
Press this button to execute the search.

Cancel
Press this button the close the dialog.



Dialog Special Search - Mixer

Use this dialog to search for tracks where either one of or both the persons you specify 
have mixed.
Select person from the drop-down lists. If you want to search for tracks mixed by both the 
persons, select AND. If you want to search for tracks mixed by only one of the persons, 
select OR.

Dialog options

Search subset
Check this if you want to search only the marked tracks.

Show all
Check this if you want CATraxx to mark all tracks found during the search and show 
them (that is, activate the View Tracks command). Uncheck this if you want CATraxx to
only show the first track found. Then choose Show Next from the Search menu to 
show the next.

Show albums
Check this if you want CATraxx to show what albums the tracks found during the search 
are located on.

OK
Press this button to execute the search.

Cancel
Press this button the close the dialog.



Dialog Special Search - Musician

Use this dialog to search for tracks where either one of or both the persons you specify 
play on.
Select person from the drop-down lists. If you want to search for tracks that both the 
persons play on, select AND. If you want to search for tracks that only one of the persons 
play on, select OR.

Dialog options

Search subset
Check this if you want to search only the marked tracks.

Show all
Check this if you want CATraxx to mark all tracks found during the search and show 
them (that is, activate the View Tracks command). Uncheck this if you want CATraxx to
only show the first track found. Then choose Show Next from the Search menu to 
show the next.

Show albums
Check this if you want CATraxx to show what albums the tracks found during the search 
are located on.

OK
Press this button to execute the search.

Cancel
Press this button the close the dialog.



Dialog Special Search - Producer

Use this dialog to search for tracks where either one of or both the persons you specify 
have produced.
Select person from the drop-down lists. If you want to search for tracks produced by both 
the persons, select AND. If you want to search for tracks produced by only one of the 
persons, select OR.

Dialog options

Search subset
Check this if you want to search only the marked tracks.

Show all
Check this if you want CATraxx to mark all tracks found during the search and show 
them (that is, activate the View Tracks command). Uncheck this if you want CATraxx to
only show the first track found. Then choose Show Next from the Search menu to 
show the next.

Show albums
Check this if you want CATraxx to show what albums the tracks found during the search 
are located on.

OK
Press this button to execute the search.

Cancel
Press this button the close the dialog.



Dialog Special Search - Song: More Than One Version

Use this dialog to search for songs that you have more than one version of. This search is 
based on Song title and, if you want, Songwriter.

Dialog options

Songwriter
Check this if you want to base the search on Song title and Song writer.

Search subset
Check this if you want to search only the marked tracks.

Show all
Check this if you want CATraxx to mark all tracks found during the search and show 
them (that is, activate the View Tracks command). Uncheck this if you want CATraxx to
only show the first track found. Then choose Show Next from the Search menu to 
show the next.

Show albums
Check this if you want CATraxx to show what albums the tracks found during the search 
are located on.

OK
Press this button to execute the search.

Cancel
Press this button the close the dialog.



Dialog Special Search - Songwriter

Use this dialog to search for tracks that either one of or both the persons you specify have 
written.
Select person from the drop-down lists. If you want to search for tracks written by both the 
persons, select AND. If you want to search for tracks written by only one of the persons, 
select OR.

Dialog options

Search subset
Check this if you want to search only the marked tracks.

Show all
Check this if you want CATraxx to mark all tracks found during the search and show 
them (that is, activate the View Tracks command). Uncheck this if you want CATraxx to
only show the first track found. Then choose Show Next from the Search menu to 
show the next.

Show albums
Check this if you want CATraxx to show what albums the tracks found during the search 
are located on.

OK
Press this button to execute the search.

Cancel
Press this button the close the dialog.



Dialog Special Search - Studio

Use this dialog to search for tracks recorded in either one of or both the studios you 
specify.
Select studio from the drop-down lists. If you want to search for tracks recorded in both the
studios, select AND. If you want to search for tracks recorded in only one of the studios, 
select OR.

Dialog options

Search subset
Check this if you want to search only the marked tracks.

Show all
Check this if you want CATraxx to mark all tracks found during the search and show 
them (that is, activate the View Tracks command). Uncheck this if you want CATraxx to
only show the first track found. Then choose Show Next from the Search menu to 
show the next.

Show albums
Check this if you want CATraxx to show what albums the tracks found during the search 
are located on.

OK
Press this button to execute the search.

Cancel
Press this button the close the dialog.



Dialog Advanced Filter

In this dialog you specify the filter criterion used to limit the albums or tracks printed. You 
can use up to 12 fields. You can group the fields in different ways. The filter criterion can be
saved to a file for later use. You enter information about the different fields you want to 
include in the query in the same way as you do when you use the simple filter. You may 
use the logical operator Or to link two fields. Press the button named OR to do this. Two 
fields that are placed on two lines next to each other are grouped by the logical operator 
AND. You add parentheses by clicking on either ( or ).

Dialog options

Add field
Press this button to add a new field (field, operator and value, also called a sub-
criterion).

Edit
Press this button the edit the selected sub-criterion.

Remove
Press this button to remove the selected sub-criterion.

OR
Press this button to add the Or logical operator.

(
Press this button to add a left parenthesis.

)
Press this button to add a right parenthesis.

Up
Press this button to move the selected sub-criterion up one line. You may also do this by 
pressing Ctrl+Up arrow, or click on the sub-criterion and then press Ctrl and hold the 
mouse-button down while you drag.

Down
Press this button to move the selected sub-criterion down one line. You may also do this 
by pressing Ctrl+Down arrow, or click on the sub-criterion and then press Ctrl and 
hold the mouse-button down while you drag.

OK
Press this button to activate the filter and close the dialog.

Cancel
Press this button the close the dialog.

Open
Press this button to open a saved filter criterion.

Save
Press this button to save the filter criterion.

Save as
Press this button to save the filter criterion under a different name.

CATraxx does not distinguish between upper and lower case characters in the filter.

The filter criterion is saved as part of the report.





Dialog Advanced Filter - Sub-criterion

In this dialog you specify the field and value you want to base this part of the filter criterion
on. You must also specify the operator that is used to compare the value of the field with 
the value you specified (for example contains, less than or between). 
CATraxx supports use of wildcards (? and ). It is only possible to use wildcards in relation 
with the operators Contains and Does not contain. A wildcard is a character that 
substitutes for and enables a match by any of the characters or set of characters in its 
place. The question mark can be thought of as a special character that means replace me 
with any character you like. The asterisk can be thought of as a special character that 
means replace me with none or more occurrences of any character you like.

Dialog options

Field values
Press this button to select a field value from the list (this is the same list that is shown 
when you choose Show Field Values from the Search menu).

OK
Press this button to activate the sub-criterion.

Cancel
Press this button the close the dialog.



Dialog Choose Field

In this dialog you choose the field to add to the report.

Dialog options

OK
Press this button to choose the selected field and close the dialog.

Cancel
Press this button to close the dialog.



Dialog Cover Report

This report prints Artist, Album title and the Cover

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
Test print Check this to only print the first page.

Include
All All albums.
Subset Only the subset (that is, albums that are marked).
Filter Use a filter to specify what albums to print.

New page
Check this if you want each album to be printed on a separate page.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Filter
Press this button to create a filter that limits what albums to print.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.



Dialog Discography

This report lists all albums released by the specified artist. The following fields are printed: 
Released, Album title, Company, Label and Catalog no. If you want, the tracks may 
also be included.

See also: Discography 

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Tracks
Check this to include the tracks.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.

The report uses all available space on the page (page width minus left and right margin). 
Increase the right margin if you think the report is too "wide".



Dialog Full Report Album

This report provides you with a detailed view all information entered about the albums. 
Every album is printed on a separate page. You should always disable the page numbering.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All albums.
Subset Only the subset (that is, albums that are marked)
Filter Use a filter to specify what albums to print.

Memo
Check this to print the memo field.

Musicians
Check this to print the musicians.

Filter
Press this button to create a filter that limits what albums to print.

Sort
Press this button to change the sort order.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.

The report uses all available space on the page (page width minus left and right margin). 
Increase the right margin if you think the report is too "wide".

Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Filter - Specify Criterion dialog 
(simple filter) or the Advanced filter dialog when you press the Filter button.



Dialog Full Report Track

This report provides you with a detailed view all information entered about the tracks. 
Every track is printed on a separate page. You should always disable the page numbering.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All tracks.
Subset Only the subset (that is, tracks that are marked).
Filter Use a filter to specify what tracks to print.

Memo
Check this to print the memo field.

Musicians
Check this to print the musicians.

Filter
Press this button to create a filter that limits what tracks to print.

Sort
Press this button to change the sort order.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.

The report uses all available space on the page (page width minus left and right margin). 
Increase the right margin if you think the report is too "wide".

Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Filter - Specify Criterion dialog 
(simple filter) or the Advanced filter dialog when you press the Filter button.



Dialog Heading

In this dialog you enter the heading that is printed at the beginning of the first page. In the 
heading you can use the code <date>, which causes CATraxx to insert the current date. 
This is very useful when a report layout is saved. In the lookup table report you can use the
code <lookup>, to automatically print the name of the lookup table.

Dialog options

OK
Press this button to save the heading and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

Alignment
Left justify The heading is left justified.
Center The heading is centered.
Right justify The heading is right justified.



Dialog Insurance Report

This report creates a simple list consisting of Artist, Album title, Album ID, Price and 
Value. Price and value is added up and the total sum is printed at the end of the report.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All albums.
Subset Only the subset (that is, albums that are marked).
Filter Use a filter to specify what albums to print.

Field names
Check this if you want to print the field names at the top of each page.

Ignore decimals
Check this if you want CATraxx to ignore decimals (0 vs. 0.00)

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Filter
Press this button to create a filter that limits what albums to print.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.

Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Filter - Specify Criterion dialog 
(simple filter) or the Advanced filter dialog when you press the Filter button.



Dialog Line Report Album

This report prints one field on each line. You may save the report layout for later use. The 
window title displays the name of the report.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All albums.
Subset Only the subset (that is, albums that are marked).
Filter Use a filter to specify what albums to print.

Field names bold
Check to print the field names in bold.

Right justify field names
Check this to right justify the field names.

Ignore empty fields
Check this if you do not want to print fields that are empty.

Ignore decimals
Check this if you want CATraxx to ignore decimals (0 vs. 0.00)

Blank line
Check this to print a blank line between each album.

List 1
This list displays all fields that are available.

>
Press this button to move the selected field from list 1 to list 2.

<
Press this button to remove the selected field from list 2.

List 2
This list displays the fields you have chosen.

Up
Press this button to move the selected field up one line. You may also do this by pressing
Ctrl+Up arrow, or click on the field and then press Ctrl and hold the mouse-button 
down while you drag.

Down
Press this button to move the selected field down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the field and then press Ctrl and hold the 
mouse-button down while you drag.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Filter
Press this button to create a filter that limits what albums to print.

Sort
Press this button to change the sort order.



Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

New
Press this button to create a new report layout.

Open
Press this button to open a saved report.

Save
Press this button to save the report. Always use lia as file extension.

Save as
Press this button to save the report under a different name.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.

Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Filter - Specify Criterion dialog 
(simple filter) or the Advanced filter dialog when you press the Filter button.



Dialog Line Report Track

This report prints one field on each line. You may save the report layout for later use. The 
window title displays the name of the report.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All tracks.
Subset Only the subset (that is, tracks that are marked).
Filter Use a filter to specify what tracks to print.

Field names bold
Check to print the field names in bold.

Right justify field names
Check this to right justify the field names.

Ignore empty fields
Check this if you do not want to print fields that are empty.

Ignore decimals
Check this if you want CATraxx to ignore decimals (0 vs. 0.00)

Blank line
Check this to print a blank line between each track.

List 1
This list displays all fields that are available.

>
Press this button to move the selected field from list 1 to list 2.

<
Press this button to remove the selected field from list 2.

List 2
This list displays the fields you have chosen.

Up
Press this button to move the selected field up one line. You may also do this by pressing
Ctrl+Up arrow, or click on the field and then press Ctrl and hold the mouse-button 
down while you drag.

Down
Press this button to move the selected field down one line. You may also do this by 
pressing Ctrl+Down arrow, or click on the field and then press Ctrl and hold the 
mouse-button down while you drag.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Filter
Press this button to create a filter that limits what tracks to print.

Sort
Press this button to change the sort order.



Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

New
Press this button to create a new report layout.

Open
Press this button to open a saved report.

Save
Press this button to save the report. Always use lit as file extension.

Save as
Press this button to save the report under a different name.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.

Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Filter - Specify Criterion dialog 
(simple filter) or the Advanced filter dialog when you press the Filter button.



Dialog List Report Album

This report prints the fields in columns just like the list in the Browse window. Each album 
may span up to three lines. You may save the report layout for later use. The window title 
displays the name of the report.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All albums.
Subset Only the subset (that is, albums that are marked).
Filter Use a filter to specify what albums to print.

Field names
Check this if you want to print the field names at the top of each page.

Ignore decimals
Check this if you want CATraxx to ignore decimals (0 vs. 0.00)

Only year
Check this if you want to ignore the day and month for date fields.

Blank line
Check this to print a blank line between each album.

Line 1/2/3
Indicates what fields that will be printed on each line. The list displays the fields and the 
percentage of the net page width each field will occupy. For example, if the page width 
is 21cm and both left and right margin is set to 1,5cm, net width is 18cm. If you have 
created 3 columns with the fields Album title (50%), Artist (25%) and Album ID 
(25%), this corresponds to column widths of 9cm, 4.5cm and 4.5cm.
Indent Specify the indent from the left margin. Applies only to line 2 and 3.
Right justify Check this if you want to right justify the line. Applies only to line 2 

and 3.
Add field Press this button to add a new field.
Remove Press this button to remove the selected field.
Properties Press this button the edit the selected field's properties.
-> Press this button to move the field to the right.
<- Press this button to move the field to the left.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Filter
Press this button to create a filter that limits what albums to print.

Sort
Press this button to change the sort order.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file



Press this button to view the ASCII-file when when printing to a file is finished.
New

Press this button to create a new report layout.
Open

Press this button to open a saved report.
Save

Press this button to save the report. Always use lst as file extension.
Save as

Press this button to save the report under a different name.
Print

Press this button to print the report.
Close

Press this button to close the dialog.

Press Ctrl+C to cancel the report.

Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Filter - Specify Criterion dialog 
(simple filter) or the Advanced filter dialog when you press the Filter button.



Dialog List Report Track

This report prints the fields in columns just like the list in the View Tracks window. Each 
track may occupy up to three lines. You may save the report layout for later use. The 
window title displays the name of the report.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All tracks.
Subset Only the subset (that is, tracks that are marked).
Filter Use a filter to specify what tracks to print.

Field names
Check this if you want to print the field names at the top of each page.

Ignore decimals
Check this if you want CATraxx to ignore decimals (0 vs. 0.00)

Only year
Check this if you want to ignore the day and month for date fields.

Blank line
Check this to print a blank line between each track.

Line 1/2/3
Indicates what fields that will be printed on each line. The list displays the fields and the 
percentage of the net page width each field will occupy. For example, if the page width 
is 21cm and both left and right margin is set to 1,5cm, net width is 18cm. If you have 
created 3 columns with the fields Song title (50%), Artist (25%) and Album ID (25%), 
this corresponds to column widths of 9cm, 4.5cm and 4.5cm.
Indent Specify the indent from the left margin. Applies only to line 2 and 3.
Right justify Check this if you want to right justify the line. Applies only to line 2 

and 3.
Add field Press this button to add a new field.
Remove Press this button to remove the selected field.
Properties Press this button the edit the selected field's properties.
-> Press this button to move the field to the right.
<- Press this button to move the field to the left.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Filter
Press this button to create a filter that limits what tracks to print.

Sort
Press this button to change the sort order.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file



Press this button to view the ASCII-file when when printing to a file is finished.
New

Press this button to create a new report layout.
Open

Press this button to open a saved report.
Save

Press this button to save the report. Always use lst as file extension.
Save as

Press this button to save the report under a different name.
Print

Press this button to print the report.
Close

Press this button to close the dialog.

Press Ctrl+C to cancel the report.

Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Filter - Specify Criterion dialog 
(simple filter) or the Advanced filter dialog when you press the Filter button.



Dialog Page Setup

The page setup dialog lets you specify margins and what fonts to use. You can use one font
for the heading and one for the rest of the report. Default page setup is defined by 
selecting File/Preferences. Settings you make here are used by default, but you may 
override this in the various reports by pressing the Page Setup button. In the page setup 
for each report, you may also specify page numbering and columns.

Dialog options

Default fonts and margins
Check this if you want to use the default fonts and margins specified in the dialog 
Preferences.

Font
Heading Is used on the heading that is printed at the beginning of the first page.
Normal Is used on the rest of the report.

Margins
Left Left margin, in inches or centimeters.
Right Right margin, in inches or centimeters.
Top Top margin, in inches or centimeters.
Bottom Bottom margin, in inches or centimeters.

Page number
Check this if you want the pages to be numbered.
Top The page number is printed at the top of the page.
Bottom The page number is printed at the bottom of the page.
Left justify The page number is left aligned.
Center The page number is centered.
Right justify The page number is right aligned.

Columns
Enter number of columns (1 to 5). Please note that when printing to a file, one column is
always used.

OK
Press this button the save any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.



Dialog Print Preview

This dialog displays the result of the print preview. We cannot guarantee that the print 
preview is 100% accurate. It works best with TrueType fonts. Please note that right justified 
fields not always are placed at the correct position. When printing to the printer everything 
works fine, though.

Dialog options

Zoom
Select the zoom-level (30-200%).

Press this button to view the first page.

Press this button to view the previous page.

Press this button to view the next page.

Press this button to view the last page.
Close

Press this button to close the dialog.



Dialog Properties

In this dialog you set the selected field's properties.

Dialog options

Title
Enter the name to be printed on top of every page. This applies only to the list report, 
not the line report.

Width
Specify the width as a percentage of the net page width (page width minus left and right
margins).

Color
Select a color from this drop-down list.

Bold
Check this if you want CATraxx to print this field in bold.

Upper case
Check this if you want CATraxx to print this field in upper case.

Alignment
The field may be left justified, centered or right justified.

OK
Press this dialog to activate any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.



Dialog Report - Cross-references

Use this dialog to print the result of the cross-references.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.



Dialog Report - Field Values

Use this dialog to control how the list in the dialog Show Field Values. is printed.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.



Dialog Report Lookup Table

This report prints the contents of the specified lookup table. Please note that you may 
enter the code <lookup> in the heading, to automatically print the name of the lookup 
table. This way, you can use the same heading for all lookup tables. For example, if you 
enter "Lookup table <lookup>, printed on <date>" as the heading, CATraxx will print 
"Lookup table Artist, printed on 10.25.1996" if you print the table Artist on Oct 25, 1996.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Blank line
Check this if you want to print a blank line between each item.

Memo
Check this to print the memo field.

Line-up
Check this to print the members of a group (Applies only to Artist).

Filter
Use this to limit what items to print. You must specify two values; from and to.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.



Dialog Simple Filter

In this dialog you specify the field and value to base the filter on. You must also specify the 
operator that is used to compare the value of the field with the value you specified (for 
example contains, less than or between). 
CATraxx supports use of wildcards (? and ). It is only possible to use wildcards in relation 
with the operators Contains and Does not contain. A wildcard is a character that 
substitutes for and enables a match by any of the characters or set of characters in its 
place. The question mark can be thought of as a special character that means replace me 
with any character you like. The asterisk can be thought of as a special character that 
means replace me with none or more occurrences of any character you like.

Dialog options

Field values
Press this button to select a field value from the list (this is the same list that is shown 
when you choose Show Field Values from the Search menu).

OK
Press this dialog to activate any changes and close the dialog.

Cancel
Press this button to ignore any changes and close the dialog.

CATraxx does not distinguish between upper and lower case characters in the filter.



Dialog Statistics Report

This report prints the following statistics: number of albums, number of tracks, playing 
time, track length, total price and value in addition to a summary of the format groups.

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All albums.
Subset Only the subset (that is, albums that are marked).
Filter Use a filter to specify what albums to print.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.

Filter
Press this button to create a filter that limits what albums to print.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

Print
Press this button to print the report.

Close
Press this button to close the dialog.



Dialog Summary Report Album

This report lets you order data into groups based on fields you select. A group value is 
printed only when the value has changed. The detail line is printed the same way as 
the list report. You may save the report layout for later use.
See also: Summary Report Album 

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All albums.
Subset Only the subset (that is, albums that are marked).
Filter Use a filter to specify what albums to print.

Ignore decimals
Check this if you want CATraxx to ignore decimals (0 vs. 0.00)

Only year groups
Check this if you want to ignore the day and month for date fields when used in groups.

Only year details
Check this if you want to ignore the day and month for date fields when used in details.

Groups
Select the fields that are used to group the report. The report is always sorted on these 
fields. A group value is printed only when the value has changed.
Color Select the color.
Bold Check this if you want to print the field in bold.
Upper caseCheck this if you want CATraxx to print this field in upper case.
Blank line Check this if you want CATraxx to print a blank line when the group value 

has changed.
Indent Specify the indent from the left margin. Applies only to group 2 and 3.

Details
Indicates what fields that will be printed on the details line. The list displays the fields 
and the percentage of the net page width each field will occupy. For example, if the 
page width is 21cm and both left and right margin is set to 1,5cm, net width is 18cm. If 
you have created 3 columns with the fields Album title (50%), Artist (25%) and 
Album ID (25%), this corresponds to column widths of 9cm, 4.5cm and 4.5cm.
Indent Specify the indent from the left margin. Applies only to line 2 and 3.
Right justify Check this if you want to right justify the line. Applies only to line 2 

and 3.
Add field Press this button to add a new field.
Remove Press this button to remove the selected field.
Properties Press this button the edit the selected field's properties.
-> Press this button to move the field to the right.
<- Press this button to move the field to the left.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.



Filter
Press this button to create a filter that limits what albums to print.

Sort
Press this button to change the sort order.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

New
Press this button to create a new report layout.

Open
Press this button to open a saved report.

Save
Press this button to save the report. Always use srt as file extension.

Save as
Press this button to save the report under a different name.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.

Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Filter - Specify Criterion dialog 
(simple filter) or the Advanced filter dialog when you press the Filter button.



Dialog Summary Report Track

This report lets you order data into groups based on fields you select. A group value is 
printed only when the value has changed. The detail line is printed the same way as 
the list report. You may save the report layout for later use.
See also: Summary Report Track 

Dialog options

Print to
Printer Print the report to the printer.
Screen View the report on the screen.
File Print the report to a file.
Test print Check this to only print the first page (printer/screen) or first 50 lines (file).

Include
All All tracks.
Subset Only the subset (that is, tracks that are marked).
Filter Use a filter to specify what tracks to print.

Ignore decimals
Check this if you want CATraxx to ignore decimals (0 vs. 0.00)

Only year groups
Check this if you want to ignore the day and month for date fields when used in groups.

Only year details
Check this if you want to ignore the day and month for date fields when used in details.

Groups
Select the fields that are used to group the report. The report is always sorted on these 
fields. A group value is printed only when the value has changed.
Color Select the color.
Bold Check this if you want to print the field in bold.
Upper caseCheck this if you want CATraxx to print this field in upper case.
Blank line Check this if you want CATraxx to print a blank line when the group value 

has changed.
Indent Specify the indent from the left margin. Applies only to group 2 and 3.

Details
Indicates what fields that will be printed on the details line. The list displays the fields 
and the percentage of the net page width each field will occupy. For example, if the 
page width is 21cm and both left and right margin is set to 1,5cm, net width is 18cm. If 
you have created 3 columns with the fields Song title (50%), Artist (25%) and Album 
ID (25%), this corresponds to column widths of 9cm, 4.5cm and 4.5cm.
Indent Specify the indent from the left margin. Applies only to line 2 and 3.
Right justify Check this if you want to right justify the line. Applies only to line 2 

and 3.
Add field Press this button to add a new field.
Remove Press this button to remove the selected field.
Properties Press this button the edit the selected field's properties.
-> Press this button to move the field to the right.
<- Press this button to move the field to the left.

Heading
Press this button to enter a heading that is printed at the beginning of the first page.



Filter
Press this button to create a filter that limits what tracks to print.

Sort
Press this button to change the sort order.

Page setup
Press this button to change margins, fonts, page numbering and columns. By default the
settings from the dialog Preferences are used.

View file
Press this button to view the ASCII-file when when printing to a file is finished.

New
Press this button to create a new report layout.

Open
Press this button to open a saved report.

Save
Press this button to save the report. Always use srt as file extension.

Save as
Press this button to save the report under a different name.

Print
Press this button to print the report.

Close
Press this button to close the dialog.

Press Ctrl+C to cancel the report.

Click with the 'other' mouse-button on the button Filter to activate this popup-menu:
· Simple Filter
· Advanced Filter

Use this menu to select whether you want to activate the Filter - Specify Criterion dialog 
(simple filter) or the Advanced filter dialog when you press the Filter button.



Dialog View File

This dialog displays the contents of the ASCII-file.



Main Windows

CATraxx has seven windows that are always visible. The position and size of these windows 
are automatically saved when you exit the program, and is used the next time you run 
CATraxx.
CATraxx 
Active Album 1 
Active Album 2 
Cover 
Tracks 
Memo 
Browse 



Window "CATraxx"

This is CATraxx's main window. You may resize it, and we recommend that you maximize it. 
The other six windows are always displayed within the frame of this window. If you 
minimize it, no other windows are visible. You see the name of the open database in the 
title bar.



Window "Active Album 1"

This window contains the standard fields. The window may be minimized. If you have 
resized it and want to set it back to default size, choose Reset size from the Window 
menu.



Window "Active Album 2"

This window contains the special info fields. You change the name of these fields by 
choosing User-defined Fields from the File menu. The window may be minimized. If you 
have resized it and want to set it back to default size, choose Reset size from the 
Window menu.

None of the user-defined fields are shown in field lists (for example when you want to 
search or print a report) before you have told CATraxx that it is in use. You do this by 
choosing Preferences from the File menu and selecting the fields you are using in the list 
box Show fields.



Window "Tracks"

This window shows all the tracks on the active album. The window may be minimized. If 
you have resized it and want to set it back to default size, choose Reset size from the 
Window menu.



Window "Cover"

This window displays the album cover. The window may be minimized. If you have resized 
it and want to set it back to default size, choose Reset size from the Window menu.



Window "Browse"

This window shows a list of all albums. To view only the subset (that is, only marked 
albums), choose Subset from the View menu. To change the browse layout, choose 
Browse Layout/Album from the File menu. The window may be minimized. If you have 
resized it and want to set it back to default size, choose Reset size from the Window 
menu.



Window "Memo"

This window holds the memo field. The window may be minimized. If you have resized it 
and want to set it back to default size, choose Reset size from the Window menu.



Operators

An operator is used to compare the value of the selected field with the value you specify 
when you search or use a filter when printing reports. CATraxx uses 14 different operators. 
If you think this sounds very complicated, you should concentrate on the two most used 
operators: Is equal to and Contains. The number of operators that are available depends 
on the field type (text, date, logical or numeric). 
Here is a list of all operators (the abbreviation is used in the dialogs Advanced Filter and 
Advaced Search):
Is equal to (==) The field must contain exactly the value you specify.
Contains (=) The field must contain the value you specify. Where in the 

field this value is located does not matter. In combination 
with this operator you may also use Wildcards.

Begins with (=*...) The field needs to begin with the value you specify.
End with (=...*) The field needs to end with the value you specify.
Is not equal to (not ==) The field cannot match exactly the value you specify.
Does not contain (not =) The field cannot contain the value you specify. In 

combination with this operator you may also use 
Wildcards.

Does not begin with (not =*...) The field cannot begin with the value you specify.
Does not end with (not =...*)The field cannot end with the value you specify.
Is greater than (>) The field needs to be greater than the value you specify.
Is greater than or equal to (>=) The field needs to be greater or equal to the 

value you specify.
Is less than (<) The field needs to be less than the value you specify.
Is less than or equal to (<=) The field needs to be less than or equal to the value you 

specify.
Is between (between) The field needs to be greater or equal to the first value you

specify and less than or equal to the second value you 
specify.

Is not between (not between) The field needs to be less than the first value you specify
and greater than the second value.



Wildcards

CATraxx supports use of wildcards (? and ). It is only possible to use wildcards in relation 
with the operators Contains and Does not contain. A wildcard is a character that 
substitutes for and enables a match by any of the characters or set of characters in its 
place. The question mark can be thought of as a special character that means replace me 
with any character you like. The asterisk can be thought of as a special character that 
means replace me with none or more occurrences of any character you like.
Here are some examples:

Album title Begins with "A*"

Search for albums where the title begins with "A", for example "Abbey Road" or 
"Achtung Baby"

Album title does not Begin with "A*"

Search for albums where the title does not begin with "A".
Artist album Contains "??????Sab*"

Search for albums where the 6 first characters may contain anything, character 7-9 
need to be exactly Sab and what the rest of the field contains does not matter.



Statusbar 1
Display the active album's number. The albums are numbered according to their position in
the window Browse. The first album is album number 1, the second is album number 2 and 
so on. If you are adding a new album, only New is shown until the album is saved.



Statusbar 2
Display the number of albums and how many of these that are marked. For example, if you
have entered 340 albums and 75 are marked, the statusbar will read 75 / 340.



Statusbar 3
Indicated whether the activate album is marked for deletion or not. To physically remove 
the album from the database, choose Compress from the File menu.



Statusbar 4
This part of the statusbar is used to provide you with information on what is happening 
when a command is activated (for example when you search, or print a report).



Memo
This field is for comments. Maximum length is 10.000 characters.



Cover
This field holds the album's cover. Only bitmaps are currently supported.

Bitmap pictures occupy a lot of disk space, but you can have CATraxx compress the 
pictures by choosing Preferences from the File menu and checking Misc. - Use 
compression / Save pictures. When using compression, bitmaps may occupy as little as 
1/8 of the original size.

It may take some time to read the picture from the database. Therefore, if you want to 
browse the database quickly, always minimize the Cover window.



Tracks
This list shows all the tracks on the active album.



New
Press this button to add a new track.



Edit
Press this button to edit the selected track.



Delete
Press this button the delete the selected track.



Browse
The list shows a list of all albums. To view only the subset (that is, only marked albums), 
choose Subset from the View menu. To change the browse layout, choose Browse 
Layout/Album from the File menu.

If you are not satisfied with the width of the columns, you can resize the columns by 
dragging the separators.

Click on the list with the 'other' mouse-button the activate this popup-menu:
· Layout
· Font
· Fixed columns
· Change Sort Order



User-defined 1
This is a text field with a maximum length of 50 characters.



User-defined 2
This is a text field with a maximum length of 50 characters.



User-defined 3
This is a text field with a maximum length of 50 characters.



User-defined 4
This is a text field with a maximum length of 50 characters.



User-defined 5
This field is linked to a lookup table. It has a maximum length of 50 characters. Type the 
value or select it from the drop-down list. Choose User-defined/User-defined 5 from the 
Lookup menu to edit this list.

Press Ctrl+W when the list has the focus to add a new item.

CATraxx does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New User-defined 5
· Edit Lookup Table



User-defined 6
This field is linked to a lookup table. It has a maximum length of 50 characters. Type the 
value or select it from the drop-down list. Choose User-defined/User-defined 6 from the 
Lookup menu to edit this list.

Press Ctrl+W when the list has the focus to add a new item.

CATraxx does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New User-defined 6
· Edit Lookup Table



User-defined 7
This field is linked to a lookup table. It has a maximum length of 50 characters. Type the 
value or select it from the drop-down list. Choose User-defined/User-defined 7 from the 
Lookup menu to edit this list.

Press Ctrl+W when the list has the focus to add a new item.

CATraxx does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New User-defined 7
· Edit Lookup Table



User-defined 8
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).



User-defined 9
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).



User-defined 10
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).



User-defined 11
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).



User-defined 12
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).



User-defined 13
This is a logical field that must contain one out of two possible values; checked or not 
checked (true/false, yes/no, on/off).



Album title
Enter the title of the album. You may use up to 75 characters.



Artist
The name of the artist that released the album. To catalog the artist:
1. Click the List button (. . . ). You see the Artist Album dialog box.
2. If the artist is registered in the database, the name is already listed. To find the 

artist, either scroll through the list and select the name you want, or type the name (or
the first characters in the name) in the text box above the list. Click the Add ( > ) 
button to move the name to the right-most list box.
You can link up to five artists to the same album. If the album is a compilation made by
several different artists, give the album a general name, for example “Various Artists”, 
and register the individual artist information when you add the tracks.
If the artist is not registered in the database, choose New. You see the New 
Artist dialog box. Fill in as much of the information as you want. You can use the Memo 
field to add personal comments about the artist. When you are ready, choose OK to 
close the dialog box.

3. Choose OK to close the Artist Album dialog box. You see the name(s) in the Artist field 
in the Active Album 1 window.



Artist button
Press this button to add new artist(s).

You may also press Ctrl+A to add new artist(s).



Company
The company that released the album. Type the name or select it from the drop-down list.

Press Ctrl+W when the list has the focus to add a new item.

CATraxx does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Company
· Edit Lookup Table



Label
Type the label name or select it from the drop-down list.

Press Ctrl+W when the list has the focus to add a new item.

CATraxx does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Label
· Edit Lookup Table



Distributor
The company that distributes the album (if known). Type the name or select it from the 
drop-down list.

Press Ctrl+W when the list has the focus to add a new item.

CATraxx does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Distributor
· Edit Lookup Table



Country
The country of origin. Type the name or select it from the drop-down list.

Press Ctrl+W when the list has the focus to add a new item.

CATraxx does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Country
· Edit Lookup Table



Condition
The physical condition of the album. Select one of the pre-defined descriptions from the list
or define your own condition as follows: 
1. From the Lookup menu choose Condition.
2. Delete the items you do not need. To do this, select the item you want to delete and 

choose Delete.
3. To add a new description, choose New and complete the information requested in the 

dialog box.

Press Ctrl+W when the list has the focus to add a new item.

CATraxx does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Condition
· Edit Lookup Table



Category
The type of music. You can select one of the pre-defined descriptions from the list or define 
your own category as follows: 
1. From the Lookup menu choose Category. 
2. Delete the items you do not need. To do this, select the item you want to delete and 

choose Delete.
3. To add a new description, choose New and complete the information requested in the 

dialog box.

Press Ctrl+W when the list has the focus to add a new item.

CATraxx does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Category
· Edit Lookup Table



Registered
The registration date. Todays date is used automatically but you can change it if you want.



Format
The type of album such as LP, CD or Cassette. You can select one of the pre-defined 
descriptions from the list or define your own format as follows: 
1. From the Lookup menu choose Format. 
2. Choose New and complete the information requested in the dialog box. You must 

specify the number of units contained in the set (for example 4 if there are four CDs in 
the box) and the number of sides each unit has (for example 1 for CDs, 2 for LPs, etc.).

Press Ctrl+W when the list has the focus to add a new item.

CATraxx does not distinguish between upper and lower case characters in this list.

Click on the list with the 'other' mouse-button to activate this popup-menu:
· New Format
· Edit Lookup Table



Released
The date the album was released. If you know the day and month, select them from the 
drop-down lists then type the year, for example 1996.



Catalog number
The record companys catalog number.



Album ID
Use this field if you have your own system for identifying albums in your music collection.



Purchased
The date you purchased the album. If the day, month or year has only one digit type a zero
( 0 ) before the numeral; for example, 06.02.97.



Playing time
The total playing time in minutes and seconds. CATraxx automatically calculates the total 
playing time after you have defined each track on the album. You can also calculate the 
total playing time by choosing Add Up Playing Time from the Album menu. If you want 
to manually enter the playing time, you must use the format mmm:ss, where m is minutes
and s is seconds; for example 053:09.



Price
The purchase price. You can decide, for example, if this refers to the price you actually paid
for the album or the retail purchase price if it is different.



Value
Current value of the album, for example the collectors value.



Change in value
The difference between price and value.



File extensions report files

lia line report album
lit line report track
lsa list report album
lst list report track
sra summary report album
srt summary report track



Procedures

In this section some of the most important procedures (for example how to create a 
database or how to search) are explained in details. Most of these examples are referring 
to the sample database (SAMPLE.MDB) that was copied to the same directory as CATraxx 
during installation.

Create New Database 
Open Database 
Backup 
Restore Backup 
Change Browse Layout Album 
Change Sort Order Album 
Transfer Lookup Tables 
Change User Defined Field Names 
Add New Album 
Delete Album 
Change Musician On More Than One Track 
View Tracks 
Change Browse Layout Track 
Change Sort Order Track 
Search For Album 
Search For Album - Show All 
Search For Tracks - Show All 
Search For Tracks - Show Albums 
Cross-references 1 - Artist Album -> Album Title 
Cross-references 2 - Artist Track -> Producer -> Song Title 
Cross-references 3 - Instrument -> Musician -> Album Title 
Discography 
Full Report Album 
List Report Album 
Summary Report Album
Summary Report Track 



Create New Database

A database is one physical file containing a set of related data tables. All information you 
enter about an album is stored in the same database. You may, however, have as many 
databases as you like. This way you can split your collection in different databases. Existing
databases can later be merged. Each database you create has a corresponding ini-file with 
the same name as the database (for example MUSIC.MDB and MUSIC.INI). This ini-file 
contains information about the browse layout and sort order.
The first you need to do after you have started CATraxx, is to open a database. You can do 
this by either open an existing database or create a new. The database that was opened 
when you exited the program, is automatically opened the next time you start it.
Follow these steps to create a new database:
1. From the File menu choose New. You see the Create New Database dialog box.
2. Select the drive and directory where you want to create the database if it is different 

from the CATraxx directory. In general, we recommend that you do not change the 
directory.

3. In the File Name text box type the name of the database. The name should be one 
that easily reminds you of the information in the database, for example MUSIC or 
MUSICLIB. As with other Windows file names, it cannot have more than eight 
characters. The file extension identifying the database, .MDB, is added automatically.

4. Choose OK.

Most of the lookup tables in a new database are empty. From the Lookup menu, choose 
Transfer to transfer the contents of one or more lookup tables from another database. For 
more information on this, see Transfer Lookup Tables



Open Database

Follow these steps to open a database:
1. From the File menu, choose Open.
2. In the Directories list box, select the drive and directory where the database is 

located if it is different from the CATraxx directory.
3. From the list box of database names, select the database you want to open and choose

OK or double-click the name.

We recommend that you open the sample database (SAMPLE.MDB) the first time you run 
CATraxx. Most examples in the documentation are referring to this database.



Backup

You create a backup copy of the open database by following these steps:
1. Choose Backup from the File menu.
2. Specify the drive and directory to copy the database to, this is usually root on drive A.
3. Press the OK button and follow the instruction on the screen.

To protect against hard disk failure, you should routinely backup your valuable data files. 
FNProgramvare has no responsibility for any loss of data.



Restore Backup

You may restore a backup by following these steps:
1. Choose Restore from the File menu.
2. Specify the drive and directory where the backup is located, this is usually root on 

drive A.
3. Press the OK button.
4. Specify the drive and directory where the database is to be copied to.
5. Insert diskette number 1 (with the file "dbname".001) into your diskette drive.
6. Press the OK button and follow the instruction on the screen.

The files are now copied to the hard disk and merged to one database.



Change Browse Layout Album

The window "Browse" displays a list of all albums (or only marked albums, if you have 
checked Subset in the View menu). By default Artist, Album title, Format and 
Released are shown, but you may define up to 5 browse layouts yourself.
Let us now change the browse layout to Album title, Company, Catalog number and 
Album ID:
1. Choose Browse Layout/Album from the File menu. You may also click with the 

'other' mouse-button on the list and select Layout from the popup-menu.
2. Select User defined 1.
3. Press the Edit button.
4. Select Album title, Company, Catalog number and Album ID from the left list box.

The fields you have chosen are now displayed in the right list box.
5. Enter a title, for example Title/Comp/Catno/ID.
6. By default the font MS Sans Serif (10 points) is used. If you want to change this, 

press the Font button.
7. Press the OK button. You are returned to the dialog Browse Layout - Album.
8. Press the OK button to activate this layout.
9. If you are not satisfied with the width of the columns, you can resize the columns by 

dragging the separators.



Change Sort Order Album

By default the albums are sorted on Artist, Released and Album title. You may however 
define up to 5 sort criteria yourself.
Let us now define a sort criteria based on Company and Released:
1. Choose Change Sort Order/Album from the File menu.
2. Select User Defined 1.
3. Press the Edit button.
4. Select Company and Released from the left list box. The fields you have chosen are 

now displayed in the right list box.
5. Enter a title, for example Comp/Artist/Title.
6. Press the OK button. You are returned to the dialog Change Sort Order .
7. Press the OK button to activate this sort criterion.



Transfer Lookup Tables

CATraxx uses a relational database model. This means that you enter most information only
once. For example, you enter an artist's name only the first time you add an album by this 
artist. Later you simply choose this name from a list. CATraxx stores the information in 
"lookup tables". The result is that you save time and avoid typing errors. The database 
occupies less space and it is easier to search for exactly the information you want.
The items in the lookup tables in a database is only accessible from within this database. If 
you work with several databases, you may want to transfer one or more tables from 
another database.
Follow these steps to transfer the lookup tables from another database:
1. Choose Transfer from the Lookup menu.
2. Specify the database you want to transfer the tables from.
3. Press the OK button.
4. Select the tables you want to transfer.
5. Press the OK button to start.



Change User Defined Field Names

In addition to the standard fields, you can define up to 20 fields for special information - 13 
fields for albums and 7 fields for tracks. These fields are ready to use, but you may want to 
change the field names to something more specific (the default names are User-defined 1, 
User-defined 2 and so on).
Follow these steps to change the names of the special fields (user-defined fields):
1. From the File menu choose User-defined Fields. You see the User-defined Fields 

dialog box.
2. In the text boxes available, type the titles of the special fields, for example 'Record 

store', 'Borrowed by' or 'For sale'. Ensure that the field number corresponds to the type
of field you want the special category to be. For example, the 'For sale' field should be 
a check box.

3. Choose OK.

None of the user-defined fields are shown in field lists (for example when you want to 
search or print a report) before you have told CATraxx that it is in use. You do this by 
choosing Preferences from the File menu and selecting the fields you are using in the list 
box Show fields.



Add New Album

Follow these steps to add a new album:
1. Choose New from the Album menu.
2. Enter relevant information in these windows: Active Album 1, Active Album 2 and 

Memo.
3. If you want to add the tracks, press the New button in the window Tracks.
4. The dialog Default Information is shown. In this dialog you enter information that is 

relevant to all tracks (or most of them). This is usually true for Artist, Songwriter, 
Producer, Mixer, Studio, Musician and Instrument. The information you enter in 
this dialog is automatically added to all new tracks you add. This way you can save a 
lot of time.

5. In the dialog Active Track you enter information about the various tracks on the album. 
Any changes are saved automatically.

6. To add the next track, press either the New or Copy button. When you choose New, 
CATraxx automatically enters all information you provided in the dialog Default 
Information. If you choose Copy, CATraxx makes a copy of the active track. When you 
are ready to add track 1 on side B (does not apply to CDs!), choose Change side. 
Because no other tracks are added to this side, CATraxx asks whether you want to add 
a new track or a copy of the active track. This corresponds to the buttons New and 
Copy.

7. Press the Close button when you are finished. Total playing time is automatically 
calculated.



Delete Album

When you delete albums as explained below, CATraxx will also compress your database to 
save hard disk space.

1. If you do not see the Browse window, open it by double-clicking the Browse icon at 
the bottom of the main window. You may also press Ctrl+B.

2. From the list of registered albums, select the album you want to delete.
3. From the Album menu choose Delete / Active album. You see the word DELETED in 

the status bar. Repeat for the other albums you want to delete (if any).
4. From the File menu choose Compress. The system asks if you want to delete the 

album(s). Click Yes.

This only marks the album(s) for deletion. To actually remove the albums from your hard 
disk, you must compress the database as explained in the next step. 



Change Musician On More Than One Track

When you add tracks to an album you can specify default information that is automatically 
added to all new tracks. This saves you a lot of work. But what do you do if you have added
all tracks and then realize that you have forgotten to enter one of the musicians? To add 
this musician to all tracks may take a lot of time! Fortunately, CATraxx makes it possible to 
edit musicians for several tracks at the same time. This is also true for artist, mixer, 
producer, songwriter and studio.
Follow these steps to add a musician to more than one track:
1. Choose Musician from the View menu.
2. The dialog View Information From Tracks - Musician displays the musicians that 

participate on the album.
3. Press the Edit button.
4. In the dialog View Musician - Edit you specify the musicians you want to add. Select the

tracks to add these musicians to, in the list box Tracks.
5. Use the check box Keep existing to specify whether to delete the musicians that are 

already added or not. If you uncheck Keep existing all musicians that are added to 
the tracks you want to edit, are all deleted! Let it remain checked if you want to keep 
the existing musicians that already are added.

6. Choose the Close button and answer Yes to save the changes.

CATraxx lets you also change artist, mixer, producer, songwriter and studio like this.



View Tracks

When you add a new album or look at existing albums, CATraxx displays the tracks in the 
same order as they are located on the album (window Tracks). Occasionally you may want 
to look at the tracks irrespective of what album they are located on:
1. Choose Tracks from the View menu. If one or more tracks are marked, CATraxx asks 

you if you want to view only the marked tracks. 
2. You see the View Tracks window. You can now browse the tracks the same way you 

browse the albums. 
To change the browse layout choose Browse Layout from the File menu, and to change 
the sort order choose Change Sort Order from the File menu. To edit the active track 
simply choose Track from the Edit menu. It is not possible to add new tracks or delete 
existing tracks when you view the tracks this way.
If you have searched for tracks and checked Show all, CATraxx will automatically activate 
the View Tracks dialog window.



Change Browse Layout Tracks

In the dialog View Tracks the tracks are shown just like the albums in window Browse. By 
default Song title, Artist and Album title are displayed, but you may define up to 5 
browse layouts yourself.
Let us now change the browse layout to Artist, Song title, Album title and Album ID:
1. Choose Tracks from the View menu to activate the dialog View Tracks.
2. Choose Browse Layout from the File menu. You may also click with the 'other' 

mouse-button on the list and select Layout from the popup-menu.
3. Select User defined 1.
4. Press the Edit button.
5. Select Artist, Song title, Album title and Album ID from the left list box. The fields 

you have chosen are now displayed in the right list box.
6. Enter a title, for example Artist/Title/AlbTitle/ID.
7. By default the font MS Sans Serif (10 points) is used. If you want to change this, 

press the Font button.
8. Press the OK button. You are returned to the dialog Browse Layout - Track.
9. Press the OK button to activate this layout.
10. If you are not satisfied with the width of the columns, you can resize the columns by 

dragging the separators.



Change Sort Order Track

By default the tracks are sorted on Song title in the dialog View Tracks. You may however 
define up to 5 sort criteria yourself.
Let us now define a sort criteria based on Artist and Song title:
1. Choose Tracks from the View menu to activate the dialog View Tracks.
2. Choose Change Sort Order from the File menu. You may also click with the 'other' 

mouse-button on the list and select Change Sort Order from the popup-menu.
3. Select User Defined 1.
4. Press the Edit button.
5. Select Artist and Song title from the left list box. The fields you have chosen are now 

displayed in the right list box.
6. Enter a title, for example Artist/Title.
7. Press the OK button. You are returned to the dialog Change Sort Order - Track.
8. Press the OK button to activate this sort criterion.



Search For Album

Let us now search for albums. We want CATraxx to only show the first album found, and 
show the rest of the albums later.
Here is an example that shows you how to find all CDs (please open the sample database, 
SAMPLE.MDB, first):
1. Choose Find/Album from the Search menu.
2. Select CD from the drop-down list Format.
3. Uncheck Search subset. We want to search all albums, no matter whether they are 

marked or not.
4. Uncheck Show all. We want to show one album at first and later choose Show Next 

from the Search menu. This is faster since CATraxx does not need to mark all albums 
that are found.

5. Choose OK to execute the search.
6. CATraxx will now show the number of albums found (if you do not want this, choose 

Preferences from the File menu and uncheck Search - Show number of records 
found). When you choose OK the first album found is shown.

7. Choose Show Next from the Search menu to show the next album that was found.
8. If you want to look at all albums found, choose Show Result from the Search menu.



Search For Album - Show All

We will now search for albums and let CATraxx show us all albums found directly.
Here is an example that shows you how to find albums with a playing time between 40 and
60 minutes (please open the sample database, SAMPLE.MDB, first):
1. Choose Simple Search from the Search menu.
2. Select Playing time from the first drop-down list (this is the field).
3. Select Between from the next drop-down list (this is the operator).
4. Enter 040:00 and 060:00 as the values to search for.
5. Uncheck Search subset. We want to search all albums, no matter whether they are 

marked or not.
6. Check Show all. We want CATraxx to mark all albums found and then show these (that

is, show the subset).
7. Press the OK button to execute the search.



Search For Tracks - Show All

Let us now search for tracks and let CATraxx show us all tracks found directly.
Here is an example that shows you how to find tracks performed by artists with a name 
that begins with "T" (please open the sample database, SAMPLE.MDB, first):
1. Choose Simple Search from the Search menu.
2. Select Artist track from the first drop-down list (this is the field).
3. Select Begins with from the next drop-down list (this is the operator).
4. Enter T as the value to search for.
5. Uncheck Search subset. We want to search all tracks, no matter whether they are 

marked or not.
6. Uncheck Show all. We want to show one track at first and later choose Show Next 

from the Search menu. This is faster since CATraxx does not need to mark all track 
that are found.

7. Uncheck Show albums. We do not want the search result to be the albums with the 
tracks that are found.

8. Press the OK button to execute the search.
9. CATraxx will now show the number of tracks found (if you do not want this, choose 

Preferences from the File menu and uncheck Search - Show number of records 
found). When you press the OK button, CATraxx shows the first track that was found.

10. Choose Show Next from the Search menu to show the next track that was found.
11. If you want to look at all tracks found, choose Show Result from the Search menu.



Search For Tracks - Show Albums

Let us now search for instrumental tracks and let CATraxx show us what albums these 
tracks are located on (please open the sample database, SAMPLE.MDB, first):
1. Choose Find/Track from the Search menu.
2. Select Yes from the drop-down list Instrumental.
3. Uncheck Search subset. We want to search all tracks, no matter whether they are 

marked or not.
4. Uncheck Show all. We want to show one album at first and later choose Show Next 

from the Search menu. This is faster since CATraxx does not need to mark all albums 
that are found.

5. Check Show albums. We want the search result to be the albums with the tracks that 
are found.

6. Press the OK button to execute the search.
7. CATraxx will now show the number of albums found (if you do not want this, choose 

Preferences from the File menu and uncheck Search - Show number of records 
found). When you press the OK, CATraxx shows the first track that was found.

8. Choose Show Next from the Search menu to show the next album that was found.
9. If you want to look at all albums found, choose Show Result from the Search menu.
10. If you want a list over all tracks that was found (that is, show the subset - in this case 

all instrumental tracks), choose Tracks from the View menu and answer Yes to the 
question if you want to show only marked tracks. Please note that you must have 
checked Search tracks - show albums - mark track in the dialog Preferences. This 
tells CATraxx to mark all tracks that are found, before the albums these tracks are 
located on are returned as the search result.



Cross-references 1 - Artist Album - > Album Title

Here we will create cross-references between Artist album and Album title (please open 
the sample database, SAMPLE.MDB, first).
1. Choose X-Ref from the Search menu.
2. Select Artist album from the drop-down list to the left.
3. Select Album title from the drop-down list over the second list box. All albums 

released by the artist selected in the list to the left are shown.
4. Try to select a different artist and watch CATraxx update the list with album titles.
5. Select U2 in the list to the left. All albums by U2 are shown.
6. To execute a search based on this cross reference, first select the first album shown in 

the second list box (Achtung Baby).
7. Select the operator >= (Is greater then or equal to) from the second operator drop-

down list.
8. Uncheck Search subset in the Search menu. We want to search all albums, no 

matter whether they are marked or not.
9. Check Show all in the Search menu. We want CATraxx to mark all albums found and 

then show these (that is, show the subset).
10. Choose Execute from the Search menu to execute the search.



Cross-references 2 - Artist Track - > Producer -> Song Title

Here we will create cross-references between Artist track, Producer and Song title 
(please open the sample database, SAMPLE.MDB, first).
1. Choose X-Ref from the Search menu.
2. Select Artist track from the drop-down list to the left.
3. Select Producer from the drop-down list over the second list box. All producers that 

have produced tracks by the selected artist, are shown.
4. Select Song title from the drop-down left over third list box. All tracks, performed by 

the selected artist, produced by the selected producer, are shown.
5. Try to select a different artist or producer and watch how the list with song titles is 

updated.
6. Select Throwing Muses in the list to the left list, and Smith, Gary in the second list 

box. All Throwing Muses tracks produced by Gary Smith, are shown.
7. Let us execute a search based on this cross-reference.
8. First, select the first track shown in third list box (Angel).
9. Select the operator >= (Is greater then or equal to) from the second operator drop-

down list. It is very important to set the operator to >=. This is because CATraxx 
compares the field value with the operator when the search is executed. Here we 
create a cross-reference between a producer and all tracks produces by this person, 
and we want to search for all these tracks, therefore we need to first select the first 
track and then choose the operator >= before the search is executed. If we did not do 
this, CATraxx would think you wanted to search for exactly the song that is selected in 
the list (since the operator was set to =).

10. Uncheck Search subset in the Search menu. We want to search all tracks, no matter 
whether they are marked or not.

11. Check Show All in the Search menu. We want CATraxx to mark all tracks found and 
then show these (that is, show the subset).

12. Choose Execute from the Search menu to execute the search.



Cross-references 3 - Instrument -> Musician -> Album Title

Here we will create cross-references between Instrument, Musician and Album title 
(please open the sample database, SAMPLE.MDB, first):
1. Choose X-Ref from the Search menu.
2. Select Instrument from the drop-down list to the left and select Drums.
3. Select Musician from the drop-down list over the second list box. All musicians playing

drums, are shown. Select Narcizo, David from this list.
4. Select Album title from the drop-down left over third list box. All album where Mr. 

Narcizo plays drums are shown.
5. We will now use the result of these cross-references to search for these albums. Select 

the operator >= (Is greater then or equal to) from the second operator drop-down list. 
It is very important to set the operator to >=. This is because CATraxx compares the 
field value with the operator when the search is executed. Here we create a cross-
reference between a musician and albums where he is playing on, and we want to 
search for all these albums, therefore we need to first select the first album and then 
choose the operator >= before the search is executed. If we did not do this, CATraxx 
would think you wanted to search for exactly the album that is selected in the list 
(since the operator was set to =).

6. Uncheck Search Subset in the Search menu. We want to search all albums, no 
matter whether they are marked or not.

7. Check Show All in the Search menu. We want CATraxx to mark all albums found and 
then show these (that is, show the subset).

8. Check Show Albums in the Search menu. We want to search for albums, but have 
used fields containing information about tracks, therefore we need to tell CATraxx to 
return albums and not tracks as the search result.

9. Choose Execute from the Search menu to execute the search.



Discography

This report lists all albums released by the specified artist. Let us print all albums released 
by R.E.M. (please open the sample database, SAMPLE.MDB, first):
1. Choose Discography form the Report menu.
2. Select R.E.M. from the drop-down list.
3. We want a print preview, select Print to/Screen.
4. Check Tracks because we want to include tracks from each album.
5. Press the Print button to print.



Full Report Album

This report provides you with a detailed view all information entered about an album. Let 
us print all albums released by Throwing Muses in the database (please open the sample 
database, SAMPLE.MDB, first):
1. Choose Full/Album from the Report menu.
2. We want a print preview, select Print to/Screen.
3. To only print albums released by Throwing Muses, press the Filter button and specify 

the following filter criterion: Artist    Is equal to    Throwing Muses. Press the OK 
button the activate this filter. CATraxx selects Include/Filter automatically.

4. We want to print as much information as possible; check Memo, Musicians and 
Tracks.

5. Press the Print button to print.
6. When you close the report window all options are saved, and are automatically loaded 

next time you select this report.

You print a full report of the activate album by clicking  on the toolbar.

The report uses all available space on the page (page width minus left and right margin). 
Increase the right margin if you think the report is too "wide".



List Report Album

We will now try to print a list of Album title, Artist, Format, Released, Album ID and 
Company. The report will span two lines (please open the sample database, 
SAMPLE.MDB, first):
1. Choose List/Album from the Report menu.
2. Press the New button to create a new report layout.
3. We want a print preview, select Print to/Screen.
4. We want to print all albums, select Include/All.
5. Album title, Artist, Format and Released are to be printed on the first line. Select 

Line 1, press the Add field button and select Album title from the list. Press Add 
field and select Artist, Add field and Format, and finally Add field and Released.

6. If you are not satisfied with the width of the columns, you can resize the columns by 
dragging the separators.

7. Company is to be printed on line 2. Select Line 2, Add field and Company. Check 
Right justify. Line 2 is then justified against the right margin.

8. Press the Properties button.
9. In the dialog Properties enter 100 in the text box Width and select Alignment/Right 

justify. Press the OK button to close the dialog.
10. Uncheck Field names.
11. Press the Sort button. Specify Album title as the sort field and press the OK button.
11. Press the Save button to save the report layout.
12. Press the Print button to print.



Summary Report Album

In this example we will create a summary report grouped by Artist, and place Album title
and Album ID on the details line (please open the sample database, SAMPLE.MDB, first):
1. Choose Summary/Album from the Report menu.
2. Press the New button to create a new report layout.
3. We want a print preview, select Print to/Screen.
4. We want to print all albums, select Include/All.
5. Select Groups and select Artist from the first drop-down list.
6. Select Details and enter 0,50 as Indent.
7. Album title and Album ID are to be printed on the details line. Press the Add field 

button and select Album title, then Add field and Album ID.
8. If you are not satisfied with the width of the columns, you can resize the columns by 

dragging the separators.
9. Press the Save button to save the report layout.
10. Press the Print button to print.



Summary Report Track

In this example we will create a summary report grouped by Artist, and place Song title, 
Album title and Album ID on the details line (please open the sample database, 
SAMPLE.MDB, first):
1. Choose Summary/Track from the Report menu.
2. Press the New button to create a new report layout.
3. We want a print preview, select Print to/Screen.
4. We want to print only marked albums, select Include/Subset.
5. Select Groups and select Artist from the first drop-down list.
6. Select Details and enter 0,50 as Indent.
7. Song title, Album title and Album ID are to be printed on the details line. Press the 

Add field button and select Song title, then Add field and Album title, and finally 
Add field and Album ID.

8. If you are not satisfied with the width of the columns, you can resize the columns by 
dragging the separators.

9. Press the Save button to save the report layout.
10. Press the Print button to print. Only marked tracks are printed.
11. To print all tracks, Select Include/All and press the Print button.



Tips

CD-ROM And Windows 95 
Go To Album/Track
Reports - Fonts
Show Fields 



CD-ROM And Windows 95

You might have a problem with CATraxx if you are running Windows 95. When you insert a 
CD into the CD-ROM, Windows 95's own CD player is automatically started. As a result, 
CATraxx is not able to access the CD-ROM before you close this CD player. 
To disable autoplay of audio CDs and CD-ROMs by default:
1. Go to Control Panel and select System/Device Manager.
2. Select your named CD-ROM drive - you may have to expand the generic CD-ROM or 

SCSI controller entry by clicking on the plus sign.
3. Click on the Properties button, then the Settings tab.
4. Uncheck Auto insert notification to disable autoplay of auto CDs.



Go To Album/Track

When you choose Go to from the Album menu or Go to from the Track menu, CATraxx 
executes this search based on the active sort order. If you specify a value that does not 
exist, CATraxx searches for the first record (that is, album or track) where the field begins 
with this value. If the first field in the sort order is not the same you are searching in, the 
result may not be what you expect. For example, if the albums are sorted by Artist and you
choose Go to Album by Album Title and enter "H", CATraxx searches for the first album 
from the top of the list in the "Browse" window where the album title begins with "H". 



Reports - Fonts

This first time CATraxx is run, the first font installed on the printer (as it is returned by 
Windows) is set to the default font. If you are not satisfied with this font, simply choose 
Preferences from the File menu, then Report and select another font. You can use one 
font for the heading and one for the rest of the report. Settings you make in the dialog 
Preferences are used by default, but you may override this in the various reports by 
pressing the Page Setup button.



Show Fields

None of the user-defined fields are shown in field lists (for example when you want to 
search or print a report) before you have told CATraxx that it is in use. You do this by 
choosing Preferences from the File menu and selecting the fields you are using in the list 
box Show fields.
To change what fields to show in lists, to the following:
1. Choose Preferences from the File menu.
2. In the list box Show fields select the fields you are using.
3. Press the OK button to save and activate the changes.




